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Introduction to Computers
I. Computer: Definition
A computer is a machine that can be programmed to manipulate symbols. Its principal
characteristics are:




It responds to a specific set of instructions in a well-defined manner.
It can execute a prerecorded list of instructions (a program).
It can quickly store and retrieve large amounts of data.

Therefore computers can perform complex and repetitive procedures quickly, precisely and
reliably. Modern computers are electronic and digital. The actual machinery (wires, transistors,
and circuits) is called hardware; the instructions and data are called software. All generalpurpose computers require the following hardware components:






Central processing unit (CPU): The heart of the computer, this is the component that actually
executes instructions organized in programs ("software") which tell the computer what to do.
Memory (fast, expensive, short-term memory): Enables a computer to store, at least
temporarily, data, programs, and intermediate results.
Mass storage device (slower, cheaper, long-term memory): Allows a computer to
permanently retain large amounts of data and programs between jobs. Common mass storage
devices include disk drives and tape drives.
Input device: Usually a keyboard and mouse, the input device is the conduit through which
data and instructions enter a computer.
Output device: A display screen, printer, or other device that lets you see what the computer
has accomplished.

In addition to these components, many others make it possible for the basic components to work
together efficiently. For example, every computer requires a bus that transmits data from one part
of the computer to another.

II. Computer sizes and power
Personal Computers

Workstations

Minicomputer
s

Least powerful

Mainframes

Supercomputers
Most powerful

Computers can be generally classified by size and power as follows, though there is considerable
overlap:

4







Personal computer: A small, single-user computer based on a microprocessor.
Workstation: A powerful, single-user computer. A workstation is like a personal computer,
but it has a more powerful microprocessor and, in general, a higher-quality monitor.
Minicomputer: A multi-user computer capable of supporting up to hundreds of users
simultaneously.
Mainframe: A powerful multi-user computer capable of supporting many hundreds or
thousands of users simultaneously.
Supercomputer: An extremely fast computer that can perform hundreds of millions of
instructions per second.

Supercomputer and Mainframe
Supercomputer is a broad term for one of the fastest computers currently available.
Supercomputers are very expensive and are employed for specialized applications that require
immense amounts of mathematical calculations (number crunching). For example, weather
forecasting requires a supercomputer. Other uses of supercomputers scientific simulations,
(animated) graphics, fluid dynamic calculations, nuclear energy research, electronic design, and
analysis of geological data (e.g. in petrochemical prospecting). Perhaps the best known
supercomputer manufacturer is Cray Research.
Mainframe was a term originally referring to the cabinet containing the central processor unit or
"main frame" of a room-filling Stone Age batch machine. After the emergence of smaller
"minicomputer" designs in the early 1970s, the traditional big iron machines were described as
"mainframe computers" and eventually just as mainframes. Nowadays a Mainframe is a very
large and expensive computer capable of supporting hundreds, or even thousands, of users
simultaneously. The chief difference between a supercomputer and a mainframe is that a
supercomputer channels all its power into executing a few programs as fast as possible, whereas
a mainframe uses its power to execute many programs concurrently. In some ways, mainframes
are more powerful than supercomputers because they support more simultaneous programs. But
supercomputers can execute a single program faster than a mainframe. The distinction between
small mainframes and minicomputers is vague, depending really on how the manufacturer wants
to market its machines.

Minicomputer
It is a midsize computer. In the past decade, the distinction between large minicomputers and
small mainframes has blurred, however, as has the distinction between small minicomputers and
workstations. But in general, a minicomputer is a multiprocessing system capable of supporting
from up to 200 users simultaneously.

Workstation
It is a type of computer used for engineering applications (CAD/CAM), desktop publishing,
software development, and other types of applications that require a moderate amount of
computing power and relatively high quality graphics capabilities. Workstations generally come
with a large, high-resolution graphics screen, at large amount of RAM, built-in network support,
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and a graphical user interface. Most workstations also have a mass storage device such as a disk
drive, but a special type of workstation, called a diskless workstation, comes without a disk
drive. The most common operating systems for workstations are UNIX and Windows NT. Like
personal computers, most workstations are single-user computers. However, workstations are
typically linked together to form a local-area network, although they can also be used as standalone systems.
N.B.: In networking, workstation refers to any computer connected to a local-area network. It
could be a workstation or a personal computer.

Personal computer:
It can be defined as a small, relatively inexpensive computer designed for an individual user. In
price, personal computers range anywhere from a few hundred pounds to over five thousand
pounds. All are based on the microprocessor technology that enables manufacturers to put an
entire CPU on one chip. Businesses use personal computers for word processing, accounting,
desktop publishing, and for running spreadsheet and database management applications. At
home, the most popular use for personal computers is for playing games and recently for surfing
the Internet.
Personal computers first appeared in the late 1970s. One of the first and most popular personal
computers was the Apple II, introduced in 1977 by Apple Computer. During the late 1970s and
early 1980s, new models and competing operating systems seemed to appear daily. Then, in
1981, IBM entered the fray with its first personal computer, known as the IBM PC. The IBM PC
quickly became the personal computer of choice, and most other personal computer
manufacturers fell by the wayside. P.C. is short for personal computer or IBM PC. One of the
few companies to survive IBM's onslaught was Apple Computer, which remains a major player
in the personal computer marketplace. Other companies adjusted to IBM's dominance by
building IBM clones, computers that were internally almost the same as the IBM PC, but that
cost less. Because IBM clones used the same microprocessors as IBM PCs, they were capable of
running the same software. Over the years, IBM has lost much of its influence in directing the
evolution of PCs. Therefore after the release of the first PC by IBM the term PC increasingly
came to mean IBM or IBM-compatible personal computers, to the exclusion of other types of
personal computers, such as Macintoshes. In recent years, the term PC has become more and
more difficult to pin down. In general, though, it applies to any personal computer based on an
Intel microprocessor, or on an Intel-compatible microprocessor. For nearly every other
component, including the operating system, there are several options, all of which fall under the
rubric of PC

III. Personal Computer Types
Actual personal computers can be generally classified by size and chassis / case. The chassis or
case is the metal frame that serves as the structural support for electronic components. Every
computer system requires at least one chassis to house the circuit boards and wiring. The chassis
also contains slots for expansion boards. If you want to insert more boards than there are slots,
you will need an expansion chassis, which provides additional slots. There are two basic flavors
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of chassis designs–desktop models and tower models–but there are many variations on these two
basic types. Then come the portable computers that are computers small enough to carry.
Portable computers include notebook and subnotebook computers, hand-held computers,
palmtops, and PDAs.

Tower model
The term refers to a computer in which the power supply, motherboard, and mass storage devices
are stacked on top of each other in a cabinet. This is in contrast to desktop models, in which
these components are housed in a more compact box. The main advantage of tower models is
that there are fewer space constraints, which makes installation of additional storage devices
easier.

Desktop model
A computer designed to fit comfortably on top of a desk, typically with the monitor sitting on top
of the computer. Desktop model computers are broad and low, whereas tower model computers
are narrow and tall. Because of their shape, desktop model computers are generally limited to
three internal mass storage devices. Desktop models designed to be very small are sometimes
referred to as slimline models.

Notebook computer
An extremely lightweight personal computer. Notebook computers typically weigh less than 6
pounds and are small enough to fit easily in a briefcase. Aside from size, the principal difference
between a notebook computer and a personal computer is the display screen. Notebook
computers use a variety of techniques, known as flat-panel technologies, to produce a
lightweight and non-bulky display screen. The quality of notebook display screens varies
considerably. In terms of computing power, modern notebook computers are nearly equivalent to
personal computers. They have the same CPUs, memory capacity, and disk drives. However, all
this power in a small package is expensive. Notebook computers cost about twice as much as
equivalent regular-sized computers. Notebook computers come with battery packs that enable
you to run them without plugging them in. However, the batteries need to be recharged every
few hours.

Laptop computer
A small, portable computer -- small enough that it can sit on your lap. Nowadays, laptop
computers are more frequently called notebook computers.

Subnotebook computer
A portable computer that is slightly lighter and smaller than a full-sized notebook computer.
Typically, subnotebook computers have a smaller keyboard and screen, but are otherwise
equivalent to notebook computers.
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Hand-held computer
A portable computer that is small enough to be held in one’s hand. Although extremely
convenient to carry, handheld computers have not replaced notebook computers because of their
small keyboards and screens. The most popular hand-held computers are those that are
specifically designed to provide PIM (personal information manager) functions, such as a
calendar and address book. Some manufacturers are trying to solve the small keyboard problem
by replacing the keyboard with an electronic pen. However, these pen-based devices rely on
handwriting recognition technologies, which are still in their infancy. Hand-held computers are
also called PDAs, palmtops and pocket computers.

Palmtop
A small computer that literally fits in your palm. Compared to full-size computers, palmtops are
severely limited, but they are practical for certain functions such as phone books and calendars.
Palmtops that use a pen rather than a keyboard for input are often called hand-held computers or
PDAs. Because of their small size, most palmtop computers do not include disk drives.
However, many contain PCMCIA slots in which you can insert disk drives, modems, memory,
and other devices. Palmtops are also called PDAs, hand-held computers and pocket computers.

PDA
Short for personal digital assistant, a handheld device that combines computing, telephone/fax,
and networking features. A typical PDA can function as a cellular phone, fax sender, and
personal organizer. Unlike portable computers, most PDAs are pen-based, using a stylus rather
than a keyboard for input. This means that they also incorporate handwriting recognition
features. Some PDAs can also react to voice input by using voice recognition technologies. The
field of PDA was pioneered by Apple Computer, which introduced the Newton Message Pad in
1993. Shortly thereafter, several other manufacturers offered similar products. To date, PDAs
have had only modest success in the marketplace, due to their high price tags and limited
applications. However, many experts believe that PDAs will eventually become common
gadgets. PDAs are also called palmtops, hand-held computers and pocket computers.
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Maintenance And Trouble Shooting
If you use your computer at home, it is essential that you know some of the basics of computer
maintenance and trouble-shooting. Even at work, it is useful to learn some of the basic things
that can go wrong with your computer, so that you don’t yell for a technician every time the
power plug falls out of the wall socket.
That may sound funny, but very often a computer failure is just a wire coming loose. When you
start working with a computer, take 10 minutes to find out how it’s wired up so you can check
the power cords first thing if it doesn’t start. Check the connections to the monitor, keyboard and
mouse if any of them fails. Don't forget to check both ends.
If you get a “non-system disk or disk error” on the screen of your monitor, this generally just
means that you have left a floppy disk in the 'A drive' of your computer. Remove it and the
machine should work 99 per cent of the time. If it doesn’t, then call the technician.
Make sure you are not running out of space. Some problems with loading new software could be
that you just don't have enough room for loading the program onto your machine. Click the “My
Computer” icon and you will see a C: icon, right click it, then move the mouse to “Properties” to
see how much room is left on your hard drive.
Some warnings signs of impending failure:








Noisy fans: The CPU is running hotter than it should
Flickering monitors: You may need to service or even change the monitor
Blurring monitors: Usually means the monitor is on its way out).
Incorrect time: The internal battery could be going flat
Programs not responding properly: A virus or a corrupt file in the program.
Printer stops printing properly: Either it has run out of ink or needs a service.
Sticky keyboard keys: The keys are worn out - you need a new keyboard

Routine maintenance
Like a car, a computer needs routine maintenance. Unlike a car, computer maintenance costs
absolutely nothing. And with Windows Maintenance Wizard, you can set it to do routine
maintenance automatically on fixed days and times, so you don’t even have to think about it.
To reach the Maintenance Wizard and set up a schedule, click on Start, point to Programs, point
to Accessories, point to System Tools, then click on Maintenance Wizard.

9

The Maintenance Wizard does three things for you:
Disk Cleanup
When you run a program, the program sometimes creates temporary files in the background to
get the work done. Though generally these temp files get deleted when you exit the program,
sometimes they don’t. Some programs may not even bother to delete them. Over time, these may
build up, taking up your hard drive's precious real estate — memory. To reclaim your disk
memory, you need to clean up these unnecessary and unwanted files.
When you surf the Net, your browser saves pages from the sites you are visiting on your hard
drive for quick viewing when you go back to these sites later. These files could be quite large, as
they often contain lots of graphics. These pages are called cached (saved) pages and they are
saved in a “Temporary Internet Files” folder in your hard drive. These pages also need to be
deleted at regular intervals to reclaim disk space. If they build up, they will choke your browser's
cache. That might lead to very slow loading of pages from the web or inability to refresh or
reload a page from the web.

Scandisk
Windows Scandisk determines if there are errors in your hard disk files and repairs any error
automatically, if you have that option selected.

Disk Defragmentation
When the computer works, it basically works with various files. It has to read files, it has to write
on files, and tries to do everything fast to keep you happy. These files are usually in your hard
disk. Since it grabs files and puts them back after use quickly, it does not usually have time to
arrange everything neatly in the hard disk. As a result, over time, the files and unused spaces in
the hard drive become unorganized (fragmented) and it takes longer for the computer to find files
when needed. This causes programs to run slowly on your computer. That is why you need to
defragment (organize) your hard disk from time to time.
Theoretically, you can work with your computer while the Disk Defragmenter is working. But
Defragmenter must restart each time other programs write to the disk. Hence it is better not to
use the computer when the Defragmenter is working. Close all programs (not the ones that run in
the background), including the screen saver, before starting Defragmenter.
Even if you move the mouse or press a key on the keyboard, the Defragmenter restarts and
begins work from the beginning. So leave it alone. Let it do its work undisturbed. It can take
anything from one hour upwards for the Defragmenter to neatly rearrange everything in your
hard drive.
Run the Defragmenter once a month. Too frequent use of it may damage your hard drive.
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Keeping the computer clean
The outside of the computer needs as much care as the inside. Such areas as
the
monitor/screen, tower or desktop, mouse and keyboard, all need careful maintenance to keep
them looking and running well.

Monitor
Clean it with a slightly damp cloth. Ensure that no water or moisture gets into the vents or
around the buttons and edges of the screen as water and electrical components don't mix. Keep
the top your monitor clear of dirt, paper, books etc, as monitors need the flow of air to keep them
from over-heating. Wipe the screen daily using window cleaner, then polish it with a clean dry
cloth.

Mouse
Sometimes the cursor moves oddly. It’s usually because dirt has accumulated around the ball
inside the mouse. Turn the mouse over and you will see the ball underneath. There is usually a
cover that can be removed and the ball can be taken out. You will see rollers inside that are
probably caked with a dirt build-up. This dirt can easily be removed with a pair of tweezers and a
cloth.
Be very careful that you do not lose any of the small parts inside. Some mice have little springs
inside, and while you are cleaning they can easily pop out!

Keyboard
Keep it clean and free from water, coffee, crumbs etc. Spill coffee or other drinks on your
keyboard.
When you are not using the computer or printer, put a dust cover on. They help keep the dust out
and save on service fees.
The following are tips on things to try if your computer is not working properly.
If your system does not start or boot

1. Check to see if your computer is properly plugged into its power source.
2. If your computer is plugged into an UPS or surge protector, make sure that it is turned on.
3. Check to insure that all the different components (i.e., keyboard or monitor) are properly
connected. Sometimes connections jiggle themselves loose.
4. Check to see if there is a non-bootable disk in the floppy disk drive.
5. Try booting from a system disk. The operating system files on your hard drive may be
damaged or missing.
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6. Unplug your system from it power source and then plug it back in. Sometimes a computer will
get stuck in hibernation or sleep mode.
If nothing appears on your monitor

1. Check to see if the monitor is turned on and properly connected.
2. Make sure that the monitor is connected to a working outlet or that the UPS or surge protector
is turned on.
3. Check to see if the screen brightness and contrast controls are in their normal position.
4. Check to see if the screen saver has been activated or the monitor is in sleep mode. Press any
key on the keyboard to turn the display back on.
5. Is the monitor power light on? If you have done steps 1 through 4 and the power light is not
on, chances are that you have a dead monitor.
If your mouse does not work, stops responding, or is jerky

1. Check to see if the mouse is plugged securely into the proper port.
2. Reboot your machine.
3. If the mouse was working and then stopped after adding new hardware or software, chances
are that there is a resource (i.e., IRQ) conflict. You can fix the problem by changing the settings
either for the mouse or for the new device.
4. Clean your mouse, it may be dirty. Turn your mouse upside down and clean the ball housing.
Open the bottom of your mouse housed according to the directions printed on it's bottom (i.e.,
<<open and >>lock) and carefully clean the ball and the housing area. Pay special attention to
the rollers.
If your printer does not work

1. Make sure that the printer is turned on and plugged in.
2. Check to see if the printer is connected properly to your computer. Be sure to check both ends
of the connection cable.
3. Check to see that the printer has paper and ink/toner.
4. Check to ensure the printer is on-line and that there are no error lights blinking.
5. Try turning it off, counting to thirty, and then turning it back on.
6. Test to determine if you are having trouble printing from DOS, Windows, or both? If you can
print from one but not the other, it may be a printer driver or capture port problem.
7. If you are having trouble printing from DOS programs, you must go into your printer's
property options and set your capture port to LPT1. If printing over a network, be sure to set the
correct printer path when you select your capture port.
If your scanner does not work
1. Make sure that the scanner is turned on and properly plugged into its power source.
2. Check to see if the scanner is connected properly to your computer on both ends of the cable.
3. If using a flat bed scanner, check to insure that the scanner is not locked (lock switch is
usually on the back or bottom).
4. Try turning the scanner off, counting to thirty, and then turning it back on.
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5. Try shutting down your entire computer system, counting to thirty, turning the scanner on
first, then turning on the rest of your computer as you normally would.

If your computer slows down
1. Close out all your running programs and delete all the *.TMP files from the
C:\WINDOWS\TEMP directory.
2. Empty out the Recycle Bin.
3. Run Disk Cleanup (START-PROGRAMS-ACCESSORIES-SYSTEM TOOLS-DISK
CLEANUP).
4. Run the Windows Defrag program (START-PROGRAMS-ACCESSORIES-SYSTEM
TOOLS-DISK DEFRAGMENTOR).
5. If the problem is with only a database program, compact/re-index the database file(s).
Backup

1. Make sure all programs and files being backed up are closed
2. Check the report to see which file being backed up failed.
3. Try the backup again.
4. Reboot all the machines in the network.
5. Try the backup once again
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MS Office
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MS Word
Introduction
Welcome to the “new world” of Microsoft 2007 Office. As you may have heard, 2007 Office is
a major change from previous Office versions. If you are new to Microsoft Office you will find
2007 very intuitive. When you click on “something,” like an image, text, or spreadsheet area,
special Ribbons, customized to your selection, will appear to assist you.
For this reason, we are creating an introduction to some of the new features of several Office
applications. First, we’ll take you through the Microsoft Office Button, the Quick Access
Toolbar, Ribbons, Tabs and Groups – to familiarize you with these common features. Then
we’ll show you some of the unique Ribbons, Tabs and Groups of each application.
If you have 2007 Office installed on your computer here are a couple of hints on how we’ll
proceed.
To open an application, Double click quickly on the application icon (Word, PowerPoint,
Excel, etc.) on the Windows desktop. Or, click the Start button, in the lower left corner of the
screen, then click All Programs, move the cursor over Microsoft Office and select the
application you desire.
In this tutorial, when we indicate that you need to click a mouse button, it will mean to click the
left mouse button – unless we indicate that you should click the RIGHT mouse button. So,
always move the cursor over the “place” we indicate and “click left” unless we tell you
otherwise.

The Microsoft Office Button
We’ll use Microsoft Word 2007
examples.

for our initial illustrations of Ribbon, Tab and Group

The first thing you’ll notice, when you open a 2007 Office application is that there is no longer a
File choice in the Menu Bar. The arrow above points to the Microsoft Office Button – which
replaces File.
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As you move your cursor over the Microsoft
Office Button a preview image (image on right)
will appear.

Click the Microsoft Office button.

When you click the Microsoft Office
button, it will turn orange and a “File
like” menu will appear (similar to the
image on the right).
You’ll notice that you now have little
images for choices and that some of them
have little arrows pointing to the right.
These arrows indicate that there are
additional choices for a selection.

We’ll show you one of these on the next
page.
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On the right side of the Microsoft Office Button menu screen you will see your most recently
used files – Recent Documents (see arrow above on right).
Each Microsoft Office Button menu is tailored to its Office application (Word, Excel,
PowerPoint, etc).

2.
3.
Move your cursor over the
arrow to the right of the Print
button ( 1. ), a menu of print
choices will appear on the
right – under Preview and
print the document ( 2. )
(image on right).

1.

Click Print ( 3.) at the top of the Menu.

A standard Print Menu screen will
appear.

It is suggested that you spend a few minutes clicking the various choices in the Microsoft
Office Button menu screen to familiarize yourself with what they do.
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If you look at the bottom
of the Microsoft Office
Button menu screen you
will see two buttons. Since
we’re using Word, the
buttons indicate Word
Options and Exit Word.

The buttons change with each application (e.g. PowerPoint will indicate PowerPoint Options).
When you click the Word Options button the image below will appear. Notice, on the left
side of the menu screen there are a number of choices (e.g. Personalize, Display, Proofing, etc.).
when you click a choice on the left side of the screen, the options for that choice appear on the
right. Take a few minutes and move through these choices to familiarize yourself with this
menu screen. You will see that Microsoft has placed a lot of resources that were under FileTools-Options, in previous versions of Office, in this menu.
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The last choice – Resources – furnishes a lot of online resources for the application which you
are using. We clicked the Microsoft Word Resources text link and the image below appeared.

Notice all of the useful online resources available to you.

Quick Access Toolbar
In the upper left corner – to the right of the Microsoft
Office Button - you will see an area called the Quick
Access Toolbar (image on left). This area is quite
handy as it currently contains several of the most used
buttons in Office applications – Save, Undo, Redo, Print and Print Preview. You can customize
this toolbar by adding and removing as many Quick Access button choices as you desire.

In the Quick Access Toolbar (on the left) you can see
we added the Insert Picture button – since we are using
it a lot for this tutorial.
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To add this button to the toolbar we first
clicked the Insert Tab and then RIGHT
clicked the Insert Picture button. One of the
choices was Add to Quick Access Toolbar.
When we clicked this choice the Insert Picture button was added. You can add any button you
choose by doing this.

To remove buttons from
the Quick Access Toolbar
just RIGHT click on the
button you desire to
remove
and
choose
Remove from Quick
Access Toolbar.

Ribbons
This is the new term you hear a lot about in 2007 Office. Ribbons stretch across the top of your
application screen with features to assist you as you click the Ribbon Tabs. To us, Tabs and
Ribbons are the same. It like unreeling holiday ribbon from a spool and seeing new images on
the ribbon – very cool! So, we’ll cover Tabs/Ribbons in great detail.

Tabs

Tab

Below the Microsoft Office Button and Quick Access Toolbar we see a series of
Tabs/Ribbons.
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Tabs are similar to the Drop Down Menu choices in previous versions of Office. The Tabs are,
logically, a bit different for each 2007 Office application to assist you with the most common
features of that application. All the 2007 Office applications begin with the Home tab.

The Home Tab/Ribbon for Word 2007 looks like the image below.

Group

The Home Tab/Ribbon for PowerPoint 2007 looks like the image below.

The Home Tab/Ribbon for Excel 2007 looks like the Image below.

The Home Tab/Ribbon for Access 2007 looks like the Image below.
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Ribbon

You’ll quickly notice that the Home Tab/Ribbon for each application shows the Clipboard as
the left “Group” (except in Access) In Word and Excel, the Font Tab/Ribbon is to the right, but
in PowerPoint, because working with slides is paramount, the Slides Tab/Ribbon comes next. If
you have 2007 Office installed on your computer, open these four applications and take a few
minutes looking at each application’s Home Tab/Ribbon.
Notice, the Tabs to the right of the Home Tab/Ribbon are tailored to each application. We’ll
work a bit with this in a little while.

Groups
In the image below, the arrows point to a new topic – Groups.

Clipboard

Font

Paragraph

Styles

Editing

Clipboard Group
The Tab/Ribbon bar images (in this tutorial) are hard to read, so we’ve placed arrows (in the
image above) for the Groups in the Word Home Tab/Ribbon. Again, the Tabs/Ribbons, and
Groups,will vary depending on the application you’re using. Let’s look a bit at the Groups in
Word.
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The first Group on the Word Home Tab is
Clipboard. To open a Group you move your
cursor over the little down pointing arrow in
the lower right corner of a group.
Open
Group

This arrow is enlarged in the image below.

Close Group

When you click this arrow the image on the
right appears.
Notice that the Clipboard
appears on the left side of your screen and shows any text or images you’ve copied. To close
this group, click the “X” in the upper right corner of the Group.

Font

Notice, in the Font Group area (above), you
have the most used Font features. However,
if you desire all of the font features, just
click the Open Group arrow to the right of
Font.
An old friend – the Font menu screen
appears (when you click the Open Group
arrow). You’ll see this a lot as your learn more
about 2007 Office. Many of the “tried and
true” menu screens will appear in logical
places.
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Select Text Mini Toolbar
When you’re working with text and fonts a really ingenious “new thing” occurs as you
highlight text - a Select Text Mini Toolbar appears!

In the image on the right we
highlighted - Highlight Text. When
we paused the cursor over the
highlight, a “shadow like” toolbar
appeared. When we move our
cursor over the toolbar, it is ready for us to use it to modify our text. This is really handy as
many of text formatting features are in the Mini Toolbar. The first time you try this, be patient, it
sometimes takes a few tries.

Paragraph
Notice in the Paragraph Group area
(left) you again have the most used
Paragraph features. However, if you
desire all of the paragraph features,
just click the Open Group arrow to the
right of Paragraph.

The Paragraph menu screen appears when you click
the Open Group arrow to the right of the Paragraph
Group. You should now have a “feel” for how the
Tabs/Ribbons and Groups work together to assist you.
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Styles
Hang on! The next Group on the Word Home Tab/Ribbon is Styles. If you go back to Page 6
and glance at the Word, PowerPoint and Excel Home Tabs, you’ll see that the right portion of a
Tab is where the application selections change to fit the application. In Word you can now
select a style from the Styles Group (image below). If you click the More arrow in the lower
right corner of the Styles group, you will see additional choices.

More
Arrow

When you click the More arrow you will see an image similar to the one below. Notice that we
are in Times New Roman – Normal. On the next page we’ll show you one of the really, really
neat new features in 2007 Office.
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Fasten your seatbelts!
We’re going to highlight this paragraph (when we have finished typing it). Then we’re going
to open the Styles Group. When the Group is open we’ll move our cursor over the choices,
and as we do, you’ll see, in the images below, that the entire paragraph changes to that Style!

We selected this Style. Look
how the text now appears!

And another………..
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Other Tabs/Ribbons
When you move to the other Tabs/Ribbons, you’ll notice that they contain their own Groups –
associated with that Tab. The Insert Tab/Ribbon (below) has logical “things” that you would
insert into a document – Shapes, Pages, Tables, Illustrations, Links, Headers/Footers, Text and
Symbols. Again, depending on your choices, many selections allow you to “preview” what
you’ve highlighted – similar to the two illustrations above.

It is suggested that you click the Tabs/Ribbons in each application you’ll be using to get a
“feel” for them.
The Page Layout Tab/Ribbon also has logical selections – Themes, Page Setup, Page
Background, Paragraph and Arrange.

The References Tab/Ribbon will really come in handy for those publishing long documents,
articles or books – Table of Contents, Footnotes, Citations & Bibliography, Captions, Index, and
Table of Authorities.
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The Mailings Tab/Ribbon lets you work with Envelops, Labels, Mail Merge, Fields and
Preview. It includes Create, Start Mail Merge, Write and Insert Fields, Preview Results and
Finish.

The Review Tab/Ribbon has the Proofing Tools, Comments, Tracking, Changes, Compare and
Protect features.

The View Tab/Ribbon allows you to change the document Views, do Show/Hide, Zoom and
arrange your Windows.

This gives you a “feel” for how the Tabs/Ribbons work in Word 2007. Again, it would be
prudent to look at the other 2007 Office applications you will be using - to get a similar
sense for these new features.
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Now we’ll look at several other neat features of 2007 Office.

Picture Tools
Currently, when you click an image in Word 2007, PowerPoint 2007 or Excel 2007, a Picture
Tools Tab/Ribbon will be available to you. We placed a Microsoft Clip Art frog on the left.
When we click the frog a Picture Tools Tab appears above of the other Tabs/Ribbons.

When you click the Picture Tools Tab (we’re still in Word) the Picture Tools Ribbon below
appears.

Notice, like the other Ribbons, that Picture Tools also has its own Groups – Picture Tools,
Shadow Effects, Border, Arrange, and Size.

You can click the Open Group arrow at the
lower right of some groups to see more of the
Group.
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We clicked the Open Group arrow on the Size Group and the Format Picture Menu Screen
appeared.
If we are in PowerPoint – and click an image – Picture Tools becomes available. The image

below shows that there are different selections since we are now using PowerPoint.

SmartArt
In the Insert Ribbon/Tab at the bottom of Page 10 there is a new selection that improves on the
“old” Drawing Toolbar – especially SmartArt. SmartArt is a part of Word, Excel and
PowerPoint.

We’ve enlarged the Word Insert
Ribbon/Tab (right) to show the
SmartArt selection. When you
click SmartArt a Choose a
SmartArt Graphic menu (image
below) will appear.

If you have used SmartArt in the past, you’ll quickly see that it has been greatly enhanced.
We’ll click on the Pyramid and then click the OK button.
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A Pyramid Diagram, similar to the one on
the right, will appear. Now it gets
exciting!

When you click the Pyramid you’ll
notice a new SmartArt Tools
Ribbon/Tab appears (top of next page).

Similar to Picture Tools, you’ll notice several Layout and SmartArt Styles Groups designed
for enhancing the Pyramid on which you’re working.

31

If you click the Change
Colors
button
in
the
SmartArt Styles Group an
image like the one the right
will appear.
As you move
your cursor arrow over the
Primary Theme Colors,
you’ll see that the Pyramid
changes to that color. We
chose the one you see marked
by the arrow on the right.
Our Pyramid now has this
shading!

If you now move your cursor
arrow over one of the images in
SmartArt Styles you’ll see an
image similar to the one on the
right.

Comparable to the Text Styles on
Page 10, you can see how 2007
Office is enhanced to assist you with
these great previews.

We’ll work with these in the
individual 2007 Office tutorials.
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MS Excel
Introduction
In the following exercises you will learn some of the necessary steps to create a spreadsheet
using Microsoft Excel 2007. You will learn not only how to type various items into the
spreadsheet, but also how to copy columns, widen columns, fill columns, add, subtract, multiply,
divide, do graphics and a variety of other “things.”
To begin, load the spreadsheet by quickly clicking twice on the Excel 2007 Windows Icon in
the Windows Desktop. If you do not see an Excel Icon, click the Start Button in the lower
left corner of the screen, move the cursor up to Programs, then move to Microsoft Office.
Move down to Microsoft Excel 2007 and click.
A spreadsheet is a “number manipulator.” To make the handling of numbers easier, all
spreadsheets are organized into rows and columns. Your initial spreadsheet will look
something like the one below:

Notice that the “main” part of the spreadsheet is composed of Rows (Labeled 1, 2, 3, 4, etc.)
and Columns (Labeled A, B, C, D, etc.). There are a lot of rows and columns in a spreadsheet.
The “intersection” of each row and column is called a cell. In the image above the cursor is
on the “home” cell – A1. Notice Row 1 and Column A are “bold,” and colored “orange.”
This indicates what is called the “address of the cell. Notice right above cell A1, that A1 is
displayed in a small box called the Name Box. Whenever you “click” on a cell the address of
that cell will be shown in the Name Box.
If you have used previous versions of Microsoft Excel you will quickly notice that the above
image is very different from what you are used to seeing. In Excel 2007 you will now use Tabs,
Ribbons and Groups, as well as special Tabs/Ribbons. These replace the Menu Bar and Buttons
in older versions. For an overview of 2007 Office, please see the Introduction to Microsoft
Office 2007 Tutorial. This short tutorial introduces you to the many enhancements in the 2007
Office Suite.
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In this tutorial, whenever we indicate that you need to click the mouse, it will mean to click
the left mouse button – unless we indicate that you should click the RIGHT mouse button.
So, always “click left” unless we tell you otherwise.
Moving Around the Spreadsheet
You can move around the spreadsheet/cells by clicking your mouse on various cells, or by using
the up, down, right and left arrow movement keys on the keyboard. Or, you can move up
and down by using the “elevator” bars on the right and bottom of the spreadsheet. Go ahead
and move around the spreadsheet. Hold down the
down arrow key on the keyboard for a few seconds –
then click-on a cell. Notice how the Name
Box always tells you “where you are.” Now hold
down the right arrow key on the keyboard for a few
seconds. Notice how the alphabet changes from
single letters (A, B, C,. …. Z) to several letter combinations (AA, AB, AC). There are
hundreds of columns and thousands of rows in a spreadsheet. Anytime you desire to return
to the Home Cell (A1) simply click-in the Name Box and type-in A1. Then tap the Enter key
and you will go to cell A1. You can go to any cell by this method. Simply type-in a row and
column, tap the Enter key, and you’ll go to that cell.

If you want to go to the last column on the right, hold down the Ctrl key and
tap the right arrow key.

If you want to go to the last row at the bottom, hold down the Ctrl key
and tap the down arrow key.

Now that you have the “feel” of how to move around the Excel spreadsheet, go to the cells as
indicated below and type-in the following:

C1

(Your Name)'s Budget. It should look similar to the image below. Do not tap Enter
when you finish
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Look at cells C1 and D1. Notice how your entry has spilled over from C1 into D1.
Sometimes this is a problem, and sometimes it is not.

There are several ways to take care of this. For the moment move back to cell D1 and click-on
cell D1. Tap the Delete key (above the arrow movement keys on the keyboard). Notice that
Bonzo disappears and your entire entry reappears. This is one way to expose the entry. We'll
look at some others as we go along.
Now we'll continue entering text and data. We think that creating a simple personal budget
would be a logical way to show you how a spreadsheet “works.” Move to the following cells
and type-in the information indicated. You can click-on each cell and then type-in the entries.
If you happen to make a mistake simply retype the entries. Later on we'll see how to
edit mistakes. Any time you want to replace something in a cell you can simply retype and the
new entry and it will replace the old one.
Cell

A10

Type-in

A3

Income

B4

Parents

B5

Job

B6

Investments

B7

Total

Expenses
B11 Food
B12

Beverages

B13

Parties

B14

Miscellaneous

B15

Total
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Your spreadsheet should now look similar to the image on the right.
At this point you probably noticed, the words "Investments" and "Miscellaneous" run over the
spaces given in the cells. Do not be concerned at this point. We’ll soon fix this.

Now, type the numbers in the cells
indicated:

C4

300
C5

50

C6

150

When you type-in the 150, tap Enter.

Your spreadsheet should look like the image
on the right.

Notice, when you enter text that the words line up on the left side of the cells.
you enter numbers, they line up on the right side. This is because we are using
United States (English) version of Excel. Other international versions will line up
logically for their text and monetary forms.

When
the

We would like to place an underline at the bottom of the three figures so that we can indicate
a total below – in cell C7. Point to cell C7 (with the mouse). That's where we want the line -always move the cursor to the place where you want to insert a line. With the Arrow on cell
C7 tap the RIGHT mouse button.
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A sub-menu with a caption Format Cells
appears.

The RIGHT click will “always bring up” a
menu that is “tailored” to the “place”
where you click. This will work in any
Microsoft Windows product.
You can
always tell “where” you click the right
mouse button for the cursor arrow will
always be in a corner of the menu that
appears – exactly where you clicked the
right mouse button..

Select Format Cells.

When the Format Cells menu screen (below) appears, select the Border Tab.

Look at the Line Style box on the
right side of the menu screen.
There are several types of lines that
you can choose. Point to the thick
single line in the Style Area (see
arrow) and click the left mouse
button. A box will go around the
line. Look at the area which says
Border. Point to the upper part of
the Text box (see arrow) and click
the left mouse button. A thick
black line will appear at the top of
the Text box.
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If the thick line does not show-up at the top of the Text box, click-again at the “top line area
in the Text box” and the line will “disappear”. Then click-on the thick, single line in the Line
Style box again and repeat the previous instructions. If, somehow, you make a mistake, simply
click “on and off in the Text line boxes.” You will notice that the lines appear and disappear.
This is called a “toggle” in computer “talk.” So, work at this until you get the line on the top of
the cell. We have indicated that we want a single thick underline at the top of the cell C7. Point
to OK and click the left mouse button.
When you return to the spreadsheet, click somewhere
other than cell C7. This is called “clicking away.” You
should now see a line at the top of cell C7. Sometimes the
box highlighting a cell hides the lines. If you “messedup”, try again.

Now type in the numbers in the cells indicated.

C11

30

C12

50

C13

150

C14

70

(After you type 70, tap the Enter key)

Now, underline the top of cell C15 like you did cell C7.

Your spreadsheet should now look like the image on the right.
Widening Columns
You probably noticed, as you typed in the numbers, some of the words were just too wide for
the default cell width (Investments and Miscellaneous). Let's widen column B to take care of
this.
Slowly move the mouse arrow to the right
edge of the B cell (between the B and the
C). The cursor will turn into an arrow
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pointing right and left with a small vertical line in the middle (see arrow below). Hold
down the left mouse button and move (drag) the line to the right.

As soon as you start to move (drag) the mouse, a dotted
vertical line will go down the spreadsheet and it will move
as you hold down the left button and drag the mouse to the
right. Keep moving your mouse to the right until you are past
the widest word - and a bit more (for some space). Release the
button. The column is widened. Notice, above the two headed
arrow cursor, that as you hold down and drag, it indicates the
current width of the column.

Here is another way to widen a column. Point to the B at the top of
column B (in the Gray area) and click the left mouse button (The cell
should turn dark blue and the column light blue.).

Now, keeping the cursor somewhere
in the “blue” area, click the RIGHT
Mouse Button. Notice that a menu
with Column Width… appears.
Click-on Column Width… A new
Column Width menu appears.
Type in 15 and click-on OK. This
is another way to widen a column.

Inserting Rows
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Oops... a mistake (on purpose). We haven't left enough room at the top of the spreadsheet to
insert some budget months. So... move the cursor to the gray 2 along the left edge (this is the
second row) so we can insert two new rows. Click the left mouse button. You will notice that
the whole row goes light blue and the 2 turn’s dark blue. Make sure the cursor arrow is
either on the 2 or somewhere in the blue row.

Click the RIGHT mouse button. A drop down menu will appear.
Point to Insert. Click the left button on Insert. Notice how one
row was inserted and how everything below moved down. Do
this again to insert another row. Excel, and all spreadsheets, will
remember where they moved your work and automatically
adjust for these changes. Income should now be in cell A5.
Aligning Cells
Now we'll type some more text. Go to cell
C3

SEPT (Type-in SEPT and tap the Enter key)

Notice how SEPT is automatically left aligned. Logically,
since you are using Excel, the English version, the text is left
aligned so that all of the text entries will line up nicely in the
column cells. We would like to center SEPT in cell C3.
Click on cell C3 to “mark” the cell. One way to center
SEPT is to simply click-on the Center button in the button
bar at the top of the screen. Make sure that you are ON cell
C3, then click-on the center button (see image above right).
You’ll notice that SEPT is now centered in cell C3.
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Here is another way to center SEPT. Click RIGHT on
cell C3. Then click on Format Cells.

When the Format Cells
Menu appears, click-on
the – Alignment Tab and
then click-on -- Horizontal
- Center --Vertical Center -- then click OK. Try
it.

This is how you can align
words for neatness. You can
also point to several cells you
want aligned and do this.
We'll try that next.

Now type the below text in the cells indicated.
D3

OCT

E3

NOV

F3

DEC

G3

MONTHLY TOTALS (tap the Enter key and then widen the width of
Column G)
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Next we’ll highlight cells C3 through G3. To do this, point to C3 and click the Left
mouse button. Then, holding down the left mouse button, drag (move) the mouse to the right
through G3 – when the cells are highlighted – take your finger off of the left mouse button.

Then point to the group of cells and click
the RIGHT mouse button to bring up the
Format Cells menu.
Click the
Alignment Tab and choose Center
(vertical & horizontal). Then point to
OK and click the left mouse button. All
of the cells will be as centered. You
could also click the Center button as you did before.
Don’t forget to widen Column G and MONTHLY TOTALS. You know what to do. Move
the cursor over the line between cells G and H and drag the line to the right to widen the G
column, just like you did a few minutes ago.

Saving Spreadsheets
We have done quite a bit of work so now is a good time to save your spreadsheet.
If you have used previous versions of Microsoft Office, 2007 Office will be quite different - in
many ways. You’ve already noticed the Tabs and Ribbons, and that there is no File choice in a
Menu Bar. Many “selections” have changed significantly in 2007 Office. This is one of them.
Microsoft Office Button
The Microsoft Office Button has
replaced File in the Menu Bar. In the
upper left corner of your Excel 2007
screen you will see a button similar to the
image on the right. This is the Microsoft
Office Button.
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Click the Microsoft Office Button.

You will now see the Excel 2007
Microsoft Office Button selections.

First, notice that many of the
“old” File-Menu Bar choices are
included in this menu (they are all
here – we’ll show you.)

When we move our cursor over
Save As an expanded menu of Save
choices appear on the right.

Notice that You can save your
spreadsheet in many different
formats.

If you save as Excel Workbook, it will save your spreadsheet in an .xlsx format. This will
save your spreadsheet in an Extensible Markup Language (XLS) format. This format
requires less storage space and makes the spreadsheet more “shareable” with others.
However, folks using previous version may have a problem opening your spreadsheet (and may
have to download a special program to assist them).

Many folks really like to save their files in Portable Document Format (PDF). One of the neat
new features of 2007 Office is the ability to save applications as PDF.
For this introductory Excel tutorial, we’d suggest that you save in the Excel 97-2003
Workbook format.

It’s your choice, so you select the format you desire.

43

Notice in the upper left corner that
there is a “box” to the right of Save In:
with a down pointing arrow to the
right. Click-on the arrow. This will
show you all of the “drives” and
“folders” where you may save your
work.

When you see the drop-down list in the Save in: area, choose the drive where you want to save
your file. If you are going to use a diskette, put a formatted 3 ½ diskette in the A Drive, then
click-on the 3 ½ Floppy (A):. We are going to save our file on the Local Disk (C:) – our hard
drive, so we chose that drive in the image above (see top arrow).
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To the right of File name:, delete the information (which is in the box) and type-in
MYBUDGET (see lower left arrow above). This is the name under which you are saving your
file. (In the future you will choose logical names for your spreadsheets as you save them.) Now
point to Save and click the left mouse button (see lower right arrow above).

Exiting Spreadsheets
Anytime you need to leave your spreadsheet, click the
Microsoft Office Button in the upper left corner of your
Excel screen, then click Exit Excel. If you have not saved
your spreadsheet, a reminder box will appear asking you to
do so.

Notice the Excel Options button to the left of Exit Excel. Earlier, we indicated that all of the
choices under File in the Menu Bar are still available using the Microsoft Office Button. Click
the Excel Options button. The Excel Options menu screen (below) will appear. As you can
see, all of the choices available under File in the menu bar are here – as well as many more.
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If you click the Resources selection in the Excel Options menu, you will see some great on-line
resources available to assist you with Excel.
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Retrieving Spreadsheets

When you need to return to a spreadsheet, open
Excel, as you did on Page 1. When Excel opens, click
the Microsoft Office Button in the upper left corner
of the Excel screen.

When you click the Microsoft Office Button you will see, on the right of the Microsoft Office
Button menu screen your spreadsheets (Recent Documents). Your MYBUDGET should be on
the list. Click on MYBUDGET and your spreadsheet will open.

If you do not see your spreadsheet, click the Open button and follow the steps you used to save
your spreadsheet (on Pages 9-11) – except choose Open.

Adding Numbers
Next we want to learn how to add numbers. There are several ways to do this. Each method
has its advantages and disadvantages.
Begin by moving your cursor to cell C9, and clicking-on cell C9.

Always move to the cell where you want the answer
to be located.
TYPE-IN METHOD
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We want to add the three numbers in cells C6, C7 and C8. To use this method type-in (using
the keys on the keyboard) the following formula in cell C9:
= C6 + C7 + C8

Your spreadsheet should look like the
image to the right as you are typing in
this equation. Note: you don’t have to
use capital (upper case) letters – we
only did this because they are easier to “see” in the tutorial.

Now – tap the Enter key. Then, click
on cell C9 again. The total of these
cells will now appear in C9.

When you have completed typing your equation, you will see
this formula in the area below the menu bar.

Change the number in cell C6 to 500 (and tap Enter). See how the total AUTOMATICALLY
recalculates!!!
THIS IS THE TRUE POWER OF THE SPEADSHEET !!!
Whenever a number is entered in a cell the entire spreadsheet will automatically recalculate.
Something happened here. Notice: you typed an (equal sign) = before the cell location. If
you had typed in C6 + C7 + C8, Excel would have thought this entry was a word (text) and this
entry would have shown as you typed it.
Try this if you want. Any time you “create” an error in Excel, you can simply re-type or edit the
formula to correct the error.
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The Type in Method is really easy if you have a few numbers and can see their cell locations
on the screen. If you have a lot of cells in the formula, which are on several screens, this is not
such a great method. The next method will work a lot better for numbers “all over the place.”

Subtraction, Multiplication, and Division
You can type a (minus) - for subtraction, (asterisk) * for multiplication, and (slash) / for
division. As you become more skilled we'll, build some effective formulas – using these
features.

Point Method
Move to cell C9 again and click-on it. We'll now add the numbers a second way. Tap the
Delete key on the keyboard to delete the current formula.

First, tap the = and then POINT (move) the cursor over cell C6 and tap the LEFT mouse
button on cell C6 (you will see a marquee box go around the cell). Now tap a + and move
cursor to C7, tap the left mouse button, and tap another
+ and move the cursor to C8 and tap the left mouse
button (notice how as you " + and point " the addition
formula is being built in cell C9), now tap Enter. The
same formula can be built using the arrow movement
keys on the keyboard (except that you don’t have to
click each cell as the cell is marked - when you move
with the arrow keys). Notice, as you are entering the cell addresses, that as you place another +
in the formula, that the cursor “returns” to cell C9. Also notice, as you point to each cell that
it is highlighted by a “marquee box.” This “tells” you what cell you’ve pointed to. Pretty
neat!
This method is good when you need to move to numbers that are spread out all over the
place. Some people like it best and use it all the time -- it's your choice.
Function Method
Move again to cell C9 and Delete the formula by tapping the Delete key.
Now type
=SUM(

in

the

following:
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[This tells Excel that we are going to sum some numbers in a RANGE which will follow the
=SUM(]

Notice – a new feature in Excel 2007: As you are typing SUM in cell C9 that a pop-up menu
appears under the cell. What you see are mathematical functions. One of these is SUM. As
you become more comfortable with numbers in Excel, you can select the functions you need
without typing in the entire function. We’ll get into this a bit more later.
There are two ways to put in this range:
Arrow Key and Anchor Method: With the keyboard arrow keys, move the cursor to cell
C6. As you move you will notice that the cell where the cursor is located appears after the
=SUM(. When you get to C6 tap the . (Period) Key. This is called an ANCHOR and holds
one end of the RANGE in place. You will notice that a C6:C6 appears in the formula area
under the button bar. This is a one cell range. Now move, with the arrow keys, to cell C8.
See how cells C6, C7 and C8 are highlighted. This indicates the Range is C6:C8. Excel
assumes, logically, that these are the numbers you want to add. Now tap Enter. The numbers
still add, but now the formula reads =SUM(C6:C8) instead of =C6+C7+C8 like it did before.

Mouse Method: Move again to cell C9. Delete the formula in cell C9 by tapping the Delete
key. Type in =SUM( as you did before. Point to Cell C6 – with your mouse cursor. Click
and hold down the left mouse button and move/drag the cursor down to Cell C8 (Cells C6, C7
and C8 should be highlighted) – take your finger off the left mouse button. Tap Enter.

This =SUM Function is a great way to add a lot of numbers, or a block/range of numbers.
By simply anchoring, and using page downs, or using the mouse, you can highlight lots and lots
of numbers to add quickly. However, since it only sums you can't do subtraction, etc.
Point to cell C9 again. Tap the Delete key to remove the formula currently in cell C9. This is a
really important DELETE, since what we’ll explain below won’t work correctly if you do not
delete the formula in cell C9.
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Functions
There are a number of formulas built
into Excel, like Sum. These formulas
are called Functions.

Another new feature of Excel 2007 –
Tabs/Ribbons. Look at the top of your
Excel screen and click on the
Formulas Tab. The Formulas Ribbon
will display.

On the left of the Formulas Tab/Ribbon is an Insert Function button. Click the Insert
Function button.

The Insert Function menu screen will
appear (image at right).

Let’s work with the Insert Function
menu screen. Click the small down
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arrow to the right of Or select a category: (see arrow at left).
In the drop down menu that appears you can see that there are all kinds of formulas (functions)
that come with Excel spreadsheet (e.g. statistical, mathematical, financial, etc.). Instead of
having to go to math, financial, or statistical tables in a book, you can enter data from your
spreadsheet into the formulas and receive answers.
This is a really great, timesaving feature. We’ll now show you how to use the Help features of
Excel 2007 to work with, and understand, these functions.

Click All in the drop down menu.

The Select a function menu will look like the image below.

Look at all the functions (formulas)! We’ll just go through how to use the addition formula
(SUM) in this tutorial. If you need these formulas in the future, you’ll know they’re here.
Use the elevator bar on the right side of the Select a function menu screen to move down the
list until you see SUM. Click SUM.
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Then click OK.
Remember, you clicked-on Cell C9 – which was “empty” because you deleted the formula in
that cell.

When you clicked OK, the Function Arguments menu screen (above) appeared. If you look
at the top of the screen in the SUM area, you’ll see that Excel 2007 has “guessed” that you
desire to add the numbers above cell C9 – where you clicked in your spreadsheet. Smart
Excel! Notice that it indicates that cells C6:C8 will be added (sum cells C6 through C8 – the
colon (:) means “through.” It also indicates the numbers in cells C6, C7 and C8 and gives you
the sum
{300;50;150} = 500 (right arrow above).
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But it’s a little unclear how Excel did this. The Help on this Excel Function is excellent. So, to
see how this SUM equation works, we’ll go to Help. To do this, click Help on this function in
the lower left corner of the screen (see lower left arrow above).

You will see a Microsoft Office Excel Help window appear (similar to the one above) that will
show you how to use this SUM function (or any function).

One of the really neat things about these Help windows is that there are examples for each
function. We moved down the SUM help screen using the elevator bar on the right of the help
screen. The bottom of the screen looks like the image below. Spend a few minutes looking at
the SUM Help window and notice all of the features.

The bottom of the
SUM help screen
looks like the
image on the left.
Notice that it gives
you
examples
from a small
spreadsheet that
has data in cells
A1 through A6. It
uses these numbers
in the examples at
the bottom of the
help screen.
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When you have reviewed all of the help you care to see, carefully click the X at the upper right
corner of the Microsoft Office Excel Help blue bar to close the Microsoft Excel Help
window. If you accidentally close the spreadsheet, simply reply yes to Save, and then reopen the spreadsheet as you did on Page 13.

The Function
Arguments
menu screen
will still be on
the screen.

As you can see, in the area to the right of Number 1, the “Wizard” has “guessed” that you want
to add the numbers in the range C6 to C8 - (C6:C8). Now that you are becoming skilled with
Excel, we’ll try something special. Carefully, point to some “plain part,” in the gray area
above. Click and hold down the left mouse button, and drag the above SUM box “away” so
that you can see your numbers in C column cells. When you have done this, release the mouse
button. Now click-on the “small box” on the right edge of the Number 1 area (see arrow
above). It has a little red arrow in it.
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The below Function Arguments window will appear.

Highlight cells C6 to C8 in the spreadsheet (click-on C6, hold down the left mouse button,
and drag until the three cells are highlighted). A “marquee” will begin to flash around the
cells, indicating they are highlighted (left arrow above). The Function Arguments area will
appear as above. Now click the small button on the right of the cell (see right arrow above).
The numbers will show in the area to the right of Number 1. Click OK at the bottom of the
Function Arguments menu screen. You’ll see that the SUM formula [=SUM(C6:C8)] shows
in the formula area at the top of the screen. This is a really handy method to highlight a
“group” of numbers you want to add.
AutoSum METHOD - ∑

Since we add numbers more than any other
operation in spreadsheets, Excel spreadsheet
has an additional feature - Auto Sum. Move
to cell C9 again and tap the Delete key to
erase your last formula.

You should still be on the Formulas
Tab/Ribbon. Notice ∑ Auto Sum button.
Click the AutoSum button.
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An image similar to the one on the left will appear.
Click ∑ Sum.
WOW !! Automatic addition!! Notice that the cells,
you’d logically desire to add, have a marquee around
them and that the SUM function is displayed in cell C9.
You’ll need to confirm that this is the correct formula.
So, tap the Enter key, and the SUM function will now
be set in cell C9. Any time you want to add using this
method just click-on the cell where you desire the total
to be and click ∑ Sum.

This would be a good time to save your work.
PERIODICALLY SAVE AND REPLACE YOUR WORK IN CASE YOU LOOSE
POWER TO YOUR COMPUTER
Now move to cell C17 and add the total Expenses in cells C13 to C16 - using each of the
four methods.
While you are in cell C17, go ahead and place a line at the top of cell C17 using the format
cells – border method that you learned on Page 5.

Subtraction
In cell A19 type-in Net Income. Next, adjust the width of column A (Page 6).

Click-on cell C19.

In cell C19 we want to subtract ( - ) the amount in for Expenses in cell C17 from the amount
for Income in cell C9. This can be accomplished by using either the Type-In Method or Point
Method. Go ahead and do this. Don’t forget to tap the Enter key to confirm your formula.
The formula should look like =C9-C17
We want our numbers to look better. To do this we'll include dollar signs and decimal points
in our numbers. This is done by using the mouse. Point to cell C6, hold down the left mouse
button and drag (move) down slowly to highlight cells C6 through C19. Your screen should
look like the image below.
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Now point anywhere in the highlighted area
and click the RIGHT mouse button. A pop-up
menu will appear. Click-on Format Cells (like
you have done before).

Your Format Cells menu screen will appear – similar to the image at the top of the next page.
Click-on the Number “Tab” at the top of the Format Cells menu screen. Point to Currency
and click-on Currency.

58

Notice several things. The right side shows the number of decimal places. The 2 is the
default for cents. We'll use 2. Notice above the Decimal Places that there is a sample of what
our number will look like. At the lower right it shows how negative numbers can appear,
depending on your choice. When a negative number is calculated, it will appear with your
choice. Now click-on OK. All the numbers now have $. If you have large numbers that are
"too wide" for the current column width you will see some ######## in the cells where these
numbers are located. If this occurs in your spreadsheet, go ahead and widen the columns as you
did previously (Page 6).

Your spreadsheet numbers should now look like
the one on the left.

Division
Now move to cell A21 and type in the word Percent. We're going to calculate a fun percentage
to show you how division works and give you some more practice with numbers.

Now move to cell C21. Using either the Type-In Method or the Point Method, divide ( / ) the
amount for Income in cell C9 by the amount for Expenses in cell C17.

[The formula should look like =C9/C17]

This will give you a horrid number so why not put a percent symbol with it. Now we’ll repeat
what we did above to format our $$$$ (Currency).
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Percentages
Point to cell C21 and click the RIGHT mouse button. Point to Format Cells, then click the
Number tab, then click-on Percentage. Select zero ( O ) Decimal Places. Click OK.
Ta Da !!!

A %.

Your spreadsheet should look similar to the image below.

Copying

We could repeat what we did to this point and
fill in the Income and Expenses for each of the
remaining columns (months).
There is a
simpler way to do this. Assuming our income
and expense amounts are about the same,
throughout the months, we want to copy the
amounts in Column C to Columns D, E and
F. This will require TWO “steps.”

First: Move your cursor to cell C6. We'll
highlight what we want to copy; second, we'll
tell the spreadsheet where we want to place
what we've copied. So, point to C6, hold
down the left mouse button and drag (move)
down the column until cells C6 through C21
are high-lighted. Your highlighted area should
look like the one on the left.

Click the Home Tab then click the Copy button.
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You will notice that once again, when you highlight an area, a marquee of running lights moves
around the copy area. So, you’ll know you highlighted the correct area (image on right).
Now we'll tell Excel where to copy the data. Point to cell D6, click and hold down the left
mouse button and drag down and to the right to cell F21 (This will highlight three columns
-- OCT, NOV, DEC -- to copy to.). When you have finished your highlighting, your screen
should look like the image below.

Make sure you are still on the Home Tab and click the Paste
button. Wow !' All those numbers and dollar signs and
formulas - EVERYTHING - was copied in a flash!! That sure
saved us a lot of time.
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Your spreadsheet should look
similar to the image on the
right.

Click on a cell away from the area where the numbers are located. This will “turn-off” the
highlight. Tap the Esc key and the marquee will also disappear.
Change a few numbers in each of the months in both the income and expense areas to
see how the spreadsheet works.
Notice how all of the formulas, totals, and percentages
AUTOMATICALLY!!! This is the POWER of a spreadsheet!!!!

change

–

(This will make the graphs we’ll create more realistic when we create them later in the
tutorial.)

Our spreadsheet now looks
like the image on the right.
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This would be a great time to Save again.
Now for something to do on your own.
Entering formulas in the Monthly Totals Column
Click cell G6 (under the title Monthly Totals). Choose one of the formulas you learned
earlier to add the four monthly amounts in the Parents row. Use any of the four
methods you desire. Your spreadsheet should look similar to the image below:

After you have added the four columns in cell G6, you’ll
copy the formula in cell G6 to cells G7 through G19.
Click on cell G6 and follow the Copy process you did on
Page 26.

Next, click on cell G7, hold down the left mouse button,
and drag down through cell G19. Your spreadsheet
should look like the one to the right.

Now follow the Paste process you used on Page 26 to
paste the formula from cell G6 to cells G7 through G19.

After you Paste your formula, you will see some "stuff
(zeroes)" in cells G10, 11, 12, and 18. This is because
there was "nothing there" to add. So, go in and “cleanup” these cells by deleting the zeros in these cells.
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Go to cells G9 and G17 and underline like you did on Page 5.

Copying the Percentage Formula

Notice that we didn’t copy the percentage formula when we did the
last copying process. If we had copied a SUM formula, it would have
added the four percentages. We don’t want the sum of the
percentages. We want a percentage of only applies to the overall
Monthly Totals. So, we need to copy the percentage formula
separately. Click on cell F21, copy the percentage formula in cell
F21 to cell G21. This is the average percentage that Income is
greater than Expenses.

Now put a $ in cells G6 through G19 (like you did on Pages 23 and
24) , and a % in G21 (Page 25). Your spreadsheet column G should
look something like the image on the right

This would be a great time to Save again.
Absoluting (and multiplication)
There are times, when we are working with a spreadsheet, that we do not want a cell to "roll"
to the next column when we use the copy feature of the spreadsheet – like it did in our last
copying exercise. To stop the cells from “rolling” we utilize something called absoluting. The
following is an illustration of absoluting.
Go to cell A23 and type-in Number. Go to cell A25 and type-in Result.
Go to cell C23 and type in the number 2 – then tap the Enter key.
We'll now create a formula to multiply our number times Net Income. You may use either the
Type-in or Point method. Go to cell C25, and type-in a formula to multiply cell C23 times cell
C19.
The formula should look like: =C23*C19

The result in C25 should be two times the net income in cell C19.
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Now copy the formula in cell C25 to cells D25, E25, F25 and G25. Your row 25 should look
similar to the one below.

Uh Oh!!! Where did all of those "0's" come from?
Point to each of the cells D25, E25, F25 and G25. Notice, as you click on each cell, and look
at the screen, how C23 (the cell with the 2) "rolled" and became D23, E23, F23 and G23
(which are blank - this caused the "0's"). A blank times a number is a “0.”We want the 2 to
be in each formula and not to "roll".
To do this we utilize something called Absoluting or Anchoring.
Go back to cell C25. Now we'll enter the formula again, but a little differently
anchor the 2).

(to

Type-in a =C23 (or you could type = and point to C23). NOW, tap the F4 function key.
Notice, in cell C25 and the Edit bar at the top of the screen, that the =C23 changes to: $C$23.
(This tells you that cell C23 is absoluted or anchored. The "$'s" indicate the absoluting.)
Now finish the formula by typing in or pointing *C17 as before. Tap Enter.
The formula in cell C25 should look like:

=$C$23*C19

Now copy the formula in cell C25 to cells D25, E25, F25 and G25 again. Your row 25 should
look similar to the image below.

The numbers should now be correct. Point to cells D25, E25, F25 and G25 (like you did
before). You will notice the "$'s" have copied the =$C$23 to each cell (absoluting) and the Net
Income figures (Cells D19, E19, F19 and G19 have “rolled” as they should. Absoluting is
something you should know and understand.
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Pause and reflect -- Look at all you have accomplished. If you want go in and change
some more numbers or change the income and expense titles to something you feel is
more fun or appropriate, please do so.
This would be a great time to Save again.
The next important lesson is to learn how to print. This done with a few easy steps.

Printing
First, click cell A1.
All of the Windows spreadsheets try to figure out what you want to print. Sometimes they're right,
sometimes they're wrong. So........
The most important thing with printing is to tell the printer what to print.
Unlike a word processor, you may need to highlight what you want to print. For the moment,
we’ll assume that Excel 2007 will “guess” correctly, and that you have not “clicked” somewhere
that will cause a problem. If you do have problems, which we’ll know in a second, we’ll show
you how to take care of the problem - a bit later.
It's usually a good idea to see what our printout will look like – before you print it. First, we’ll
use a Print Preview to “see” what our spreadsheet looks like.

Click the Microsoft Office Button.

When the menu screen appears, move your
cursor over Print and then click the Print Preview choice.
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At the top of the Print Preview
screen you will see the Print
Preview Tab.

We’ll these buttons to assist us with
our printing.

Notice: the Next and Previous buttons are not highlighted – they are just gray. This means that
the buttons are not “active.” This indicates that we are OK with our spreadsheet – it is all on
one page. If we saw that the Next button was active, this would mean that there are other pages
to our spreadsheet. If you’ll look at the lower left corner of the Print Preview screen you’ll
see: Preview: Page 1 of 1. This confirms that our spreadsheet is on one page. If you do not
see this “combination,” we’ll show you how to take care of it later.

If you do see this combination, click the Print button. Then,
Click-on OK in the Print menu screen that appears.

Label (write on) this printout: Default Spreadsheet Printout.
A picture, of what the printout will look like, appears below.
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The “image” above should also look similar to your spreadsheet.

If you move your cursor over the spreadsheet, you’ll notice that the
cursor changes from an arrow to a tiny magnifying glass. If you click the
left mouse button, your magnifying glass will “zoom-in” on the exact
spot where the magnifying glass is located. If you click-again, it will
zoom-out. Try this a couple of time. It is a really handy feature.

Now click the Page Setup button on the Print
Preview Tab.

The Page Setup menu screen at the top of the next
page will appear.
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Notice that the Page Setup menu screen indicates that you are in Portrait view. Now we’ll
enhance the spreadsheet to make it a bit more presentable. In the Orientation area click-in the
small circle to the left of Landscape (see arrow above). The spreadsheet will now print on the
page as indicated. Next, in the Scaling area, click-in the box to the left of % normal size.
Using either the “up/down” arrows, or by typing in the information, change the size to 125.
Then click OK.
Your spreadsheet will now be larger and fill the paper more appropriately. Click-on Print and
when this spreadsheet comes out of the printer label it: Landscape – enlarged to 125 %.
Go ahead and adjust the “size” of your spreadsheet so that it becomes too large to fit on a single
page. Set the Scaling to 200 and click OK. When you return to the Preview screen, the Next
and Previous buttons at the top left will now be active, and you’ll see 1 of 3 or 4 pages in the
lower left corner of the screen. Go ahead and click the Next and Previous buttons to get a
“feel” for the “size” of your spreadsheet. If you click-on Print (please don’t do it), you’ll get
these 3 or 4 pages. If you made a mistake when you created the spreadsheet, you might see that
you have 58 (or some big number of) pages in your spreadsheet!
Now, click-in the small circle to the left of Fit to 1 page(s) wide by 1 tall in the Scaling area
and make sure that 1 page is set. Excel 2007 will now return your spreadsheet to one page. Try
other things here. Work with the Margins, Header/ Footer, and Sheet tabs at the top of the
Page Setup menu screen. Any time you desire to print, go ahead and do so. This will give you a
feel for how the spreadsheets will print. When you are finished, simply click OK or Cancel and
you will return to your spreadsheet.
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Many people ask how to center a spreadsheet on the page. This feature is located on the
Margins Tab at the bottom left of the Margins screen.

Many users also ask how to place gridlines and show the row and column headings (A, B, C
and 1, 2, 3) in their spreadsheet printouts. This feature is located on the Sheet tab in the Page
Setup menu screen.

When you are finished working with Print Preview, click the Close Print Preview button.
When you return to your spreadsheet you will see “dashed lines” around your data. Print
Preview added these to assist you in knowing where the “edges” of your printed data will be on
paper. We’ll show you a nice new feature that assists even more in a minute.

Cure for the problem – if you have too many spreadsheet pages.

Click cell A1 and highlight your
spreadsheet down through cell G25.

After you’ve highlighted A1 through
G25, click the Microsoft Office Button
and then click Print. In the Preview and
print the document area (on the right)
click Print

A Print menu screen will appear.
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In the lower left corner of the Print menu screen you will see an area that looks like the image
on the right. Click-in the small circle to the left of Selection. This indicates to Excel that you
only want to print the area you’ve highlighted. Click OK. Only the section that you’ve
highlighted will print. You can still modify your spreadsheet if you desire. Once you’ve
clicked Selection, you may click-on the Preview button to see a preview of your highlighted
area. Follow the instructions above to modify as you desire.

Page Layout View
Now that you have a “feel” for printing your spreadsheets, we’ll look at a neat new feature in
Excel 2007 – Page Layout View. In the lower right corner of your Excel screen you’ll see the
Excel 2007 Toolbar.

Page Layout View

Zoom

The Excel View Toolbar
looks similar to the image on
the right.
Normal View

Page Break View

You are currently in Normal View. Look at your screen and then click the Page Layout
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button (as shown above) on the Excel View Toolbar. Your Excel screen should look similar to
the image below. Wow! Your screen now has all the settings you entered in Print Preview.
Notice the Rulers at the top and on the left – just like Microsoft Word! So you now have a very
accurate Print Preview as you are working.
Spend a few minutes using the Elevator Bars on the Right side and Bottom of your Excel
spreadsheet to move up and down and left to right. As you move you’ll see the Page Breaks and
Pages as they’ll Print!

Headers and Footers
Look at the top of your spreadsheet and you’ll also see an area which indicates: Click to add
header.

If you desire a Header (or Footer) on each spreadsheet page, you can now create them in this
view! Notice (above) we’ve moved our cursor over the center Header area (the Footer area is
at the bottom of the page). When we did it turned light blue. If you move your cursor over the
left and right Header areas, you will see that they’ll turn blue as well. If you then click on one of
these areas you’ll see a Header & Footer Tools Tab – with a Design Tab below. In the Design
Ribbon you’ll see that this Tab/Ribbon is “tailored” to work with creating your Headers and
Footers. This is one of the great new features in 2007 Office and Excel.
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Go ahead and experiment as you desire. This new feature really makes working with Headers
and Footers really easy.

Print Preview Button in Quick Access Toolbar
Since you’ll be using the Print Preview feature frequently, it would be nice to have a button
in the Excel Quick Access Toolbar, so you won’t have to do all that “clicking.”

To add a Print Preview button click the
Microsoft Office Button - like we did to
open our Print Preview..

When the menu screen appears, move your
cursor over Print and then move the
cursor over the Print Preview choice.
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When the Print Preview selection “turns orange,” click the RIGHT mouse button and a popup menu will appear.

Move your cursor over the Add to Quick Access Toolbar selection and click the left mouse button.

As soon as you “click” you’ll see your Print
Preview button added to the Excel Quick Access
Toolbar! Now, anytime you desire to Print
Preview your spreadsheet, all you’ll have to do is
click the Quick Access Print Preview button.

As you see other buttons you would like to add to your Excel Quick Access Toolbar, simply follow the
instructions above.

Graphics
This will be a lot of fun. We are now going to turn your spreadsheet numbers into graphics - bar
charts, pie charts, etc. This will greatly assist you when you display and explain your work. A
new – really awesome – feature in Excel 2007 is Conditional Formatting. We’ll begin with
Conditional Formatting and them move to full page Charts.

Conditional Formatting
Conditional Formatting will let you show graphics in your spreadsheets!
The best way to describe this amazing new feature is to show you how it’s
done.

First, you’ll need to highlight some of the data on your spreadsheet. We
highlighted the Income and Expense numbers for the month of December
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for our image. Our Conditional Formatting graphics will appear in this column.
Now, look at the Tabs at the top of your Excel screen and make sure you are on the Home Tab.
Under each Tab is a Ribbon made up of Groups (Clipboard, Font, Alignment, etc.). Over to
the right is a Conditional Formatting selection in the Styles Group.

Groups

When you move your cursor over the
Conditional Formatting button, an image
similar to the one on the right will appear.
We’ve enlarged the image so you can get
an idea of how this feature will work.

In the lower right corner of the Conditional Formatting button is a small down arrow.
Click on this arrow.
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When you click the down arrow the image on the
right will appear. Notice the Data Bars, Color
Scales and Icon Sets choices.

As you move your cursor over these selections you
will see that a number of choices are available with
each option.

To show you how
this works we
moved our cursor
over Data Bars.
our cursor
the right.

over

Then, we moved
Blue selection on

the

Notice, our December
Column data is now
highlighted in blue.

Also notice that the
larger numbers have a
longer blue bar
highlight with them.
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This is really a neat new feature. Go ahead and look at Color Scales and Icon Sets as well.
Experiment as you like. If you click a selection it will show that graphic on your spreadsheet. If
you go to Print Preview, you will see that effect. Now you can print spreadsheets that have not
only data numbers, but a graphic to show their size!
If you don’t like the Conditional Formatting effects, you can use the Undo
Arrow (in the Quick Access Toolbar) to remove them.

Charts
Before we work with Charts, there are a couple of ESSENTIAL steps we have to do. First, we
have to tell Excel 2007 what we want to see in our chart and then were we want the chart to
go.
First: in cell B9 type-in Income (to replace the word Total). Next, type-in Expenses in cell
B17 for the same reason. You’ll see why we do this when you see your chart.
VERY IMPORTANT………. But Tricky!
Something new.... Hold down the left mouse button and highlight cells B3 to F3. Next,
HOLD DOWN a Ctrl key at the bottom of the keyboard and, while you are holding Ctrl
down, highlight cells B9 through F9. You will now see two "ranges" highlighted. Hold
down the Ctrl again, and highlight cells B17 through F17. These three ranges will make up
your chart. The x-axis will be made up of cells B3 through F3. And, the two sets of bars –
Series - will show Income and Expense. When you complete the above instructions, your screen
should look like the image below.
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If your spreadsheet does not look exactly like the one above, please try again. This is a bit
tricky and it often takes (even experienced spreadsheet users) a couple of “tries” to get the
highlighting just right.
What we are about to do is entirely new in Excel 2007. So, if you have used previous versions
of Excel – hang on – this is awesome!
Click the Insert Tab at the top of the Excel screen. When you do you’ll see that one of the
Groups in the Insert Tab/Ribbon is Charts.
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For our first chart, we’ll use a Column Chart. Move
your cursor over Column and an image like the one on
the right will appear.

Click the Column button and you’ll see an image
like the one on the left. As you can see there all
kinds of Column Charts. We’ll begin with a simple
two dimension 2-D Column chart. You’ll be able to
change this later, if you desire – to another Column
Chart of one of the other selections.

Click on the 2-D Column chart indicated by the
arrow on the left.

As soon as you click, because you highlighted your data, an image similar to the one below will
appear. Don’t worry that the Chart is covering your data – we’ll take care of that in a
minute.

Notice that when we highlighted cells B3 to F3 this created the X-Axis labels (SEPT, etc.).
When we highlighted cells B9 to F9 and B17 to F17 this created the two Income and Expense
bars for each month. And, when you typed Income into B9 and Expenses into F9 this created
a Legend on the right side of your chart.
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Now, let’s move our chart to a page of its own – so it will be easier to work with and not cover
our data. Click anywhere on your chart and you will notice that a new Tab appears at the top
of your Excel screen – Chart Tools. Click the Chart tools Tab and the Chart Tools
Tab/Ribbon will appear like the image below.

Notice, on the right end of the Chart Tools Tab/Ribbon is a
Move Chart Location button. Click the Move Chart
Location button.
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When you click the Move Chart Location button a Move Chart menu screen will appear
(like the image below).

Click on the small circle to the left of New Sheet and change Chart 1 to My Budget Chart – as
indicated above. Then click the OK button.
Look at the bottom left of your Excel screen. You will see a new Tab – My Budget Chart!
Your data is on Sheet 1. We’ll rename it when we have finished working with our chart.

You should be on you’re My Budget Chart Tab. If not, click this tab. Your chart should now fill
the Excel screen. Click in one of the outside corners of your chart.
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Chart Tools
Make sure that you can still see the Chart Tools Tab/Ribbon. If not, click the Chart Tools Tab.

Notice that there is a Chart Layouts
Group in the Chart Tools Ribbon.
There are many different Layouts you
can choose to enhance your chart.

Click the More down arrow in the
lower right corner of the Chart Layouts Group.

When you click the More arrow an image similar to
the one on the right will appear. We’ll choose the
Layout in the upper left corner. We’ll click on
this choice

As you become more experienced with Charts, you
choose the Layout that will best display your data.

You can also enhance the colors of your chart bars
and backgrounds in a similar manner. To the right
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of the Chart Layouts Group is the Chart Styles Group. To see these styles, click the More
down arrow on the lower right of the Chart Styles Group.

Chart Styles
A Chart Styles menu screen (similar to the one below) will appear. You can click the various
choices as you desire. Each time you click, you’re My Budget Chart will change to the Style you
chose.
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If you don’t like the Chart Styles, you can use the Undo Arrow (in the
Quick Access Toolbar) to remove them.
A note – as you choose different Chart Types, you will see the Chart Styles menu (above)
change to that new Chart Type.

We’ll show you another way to enhance the colors of your bars in a moment.

If you would like to change your Chart
Type – look in the upper left corner of
the Chart Tools Ribbon. You’ll see a
Change Chart Type button.

Click the Change Chart Type button.

A Change Chart Type menu screen (below) will appear. Currently it is “on” our
2-D Column Chart. We’ll change it to a 3-D Clustered Column chart next.
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We’ll click the 3-D Clustered Column choice and then click the OK button. As soon as we
click the OK button our entire chart changes to a 3-D Chart.
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Another way to change chart colors

On Pages 44 & 45 you saw how you could
change the colors of the bars in your chart
(Chart Styles). Here is the second way to
change colors that we promised.

Move your cursor over one of the bars in
your chart and click the RIGHT mouse button. When the pop-up menu appears, click the
Format Data Series… selection.

A Format Data Series menu screen (like the one below) will appear “over” your chart. In our
original chart the Income bars were blue. We think green would be a better color for our Income
bars. So, we clicked the Fill choice on the left. When the Fill menu appeared on the right, we
clicked the small circle to the left of Solid fill and then clicked the down arrow on the right
side of the Color button. Then we clicked the green color choice (if you would like to see a lot
more colors you can click More Colors…). As soon as we clicked our Income bars changed to
green.

Notice the other choices in the Fill menu area. Experiment with the other choices as you desire.
You can really get some neat effects with Gradient and Picture or texture fill.

When you are finished, click the Close button.
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Changing Text
To change text in Excel 2007 you need to click on the text, the Legend, or the axis on which
the text is located.

We RIGHT clicked on our Chart Title and
two menus appeared. The upper menu is
another new, great feature in Excel 2007. It’s
called the Mini Toolbar. The lower menu is
the standard menu that appeared previously.

We clicked the down arrow to the right of
Calibri and a drop down menu of font
choices appeared. We moved down the list
and clicked-on Comic Sans MS. You move
down the menu and choose a font you like.

As soon as we clicked our font choice, our
Chart Title changed to that font.

You can also change the Font size, Bold,
Color, and more using the other Mini
Toolbar selections. Experiment as you desire

Now we’ll change our Chart Title to something more
meaningful. Move your cursor over Chart Title and
click the left mouse button three times quickly. This
will highlight all of the title – just like Microsoft
Word. Or, you can click and drag your cursor of the
title to highlight Chart Title.
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Type in a title for your budget. We typed in the title you see below. When you have finished
typing your title, click the left mouse button in an “open” area of your chart (to turn-off and
confirm the title)

If you desire to enhance your
text some more, RIGHT click
on the title and the Format
Chart Title menu screen will
appear. You can use this menu
to augment your text.

Now it would be a good time to Save again.
In Excel 2007, when you save your spreadsheet, you also save your graph. Your graph is
saved wherever you are working in the graph.
Changing (Renaming) Excel 2007 Tabs
If you would like to have logical names for your Excel 2007 spreadsheet tabs – rather than
Sheet 1 and Chart 1, we’ll show you how to do this.
At the bottom of your spreadsheet you will see you tabs (like the image on the below). To
change the name of one of the tabs, place your cursor over a tab and click the RIGHT mouse
button.

We’ll change the name of Sheet 1 first.

RIGHT click on Sheet 1and the drop down menu screen to the
right will appear. Choose Rename.
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When you choose Rename, the Sheet 1 tab will “turn black” – like
the image on the right. As soon as you see this, type in the name
you want for your chart. We typed in Budget Data.
As soon as we began typing, the tab name changed. When we finished, the Tabs for our Chart
and Data looked like the image on the below.

So, anytime you need to change Tab names, all you have to do is Right Click and Rename.
Some additional Charting
Sizing your Graph Area - Click-on the upper right corner of your chart area. You will see
little circles now appear at the four corners and sides of the graph area. Point to the upper right
corner circle and move the cursor until you see an arrow with two heads  . Click and hold
down the left mouse button and drag down and to the left then let go. Your graph will get
smaller. You can make the graph area of your chart smaller or larger as you desire.
Legend Area - Click-on the Legend on the right (box with Income and Expenses). When you
see the corner “grabbers,” make the Legend box a bit larger. Then click right in the Legend
area. When the Quick Toolbar appears, make the font bold and size 14.
Printing Charts - Now let's look at your graph and then print it. Click the Print Preview
button you placed in the Quick Access Toolbar. If you like what you see go ahead and print
the graph. If not, close Preview and make some more graph changes. If you have a color
printer, your graph will print in color.
Whenever your graph is visible, you can point to any area of the graph, and click the right
mouse button on the area, and edit that particular area. You can also click-right in the chart
itself.
You can really go “wild” at this point. If you make a mistake, simply click the
undo button at the top of the menu screen and try again.
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Internet & E-Mails
The word internet is used to describe a network of networks which incorporate a very large and
complicated set of equipment. To understand the internet, there are three areas of discussion
which are very helpful. These include the various services provided across the internet, the
functions that enable the internet to work, and the various organizations that are part of the
internet.

Internet Services
The main services used on the internet include:



Web browsing - Supported by the HTTP protocol, this functions allows users to view
web pages using a web browser.
E-mail - Allows people to send and receive electronic messages.

Other lesser used services include telnet (allows remote login to computers), FTP (Allows quick
file transmission to remote computers), and gopher (An early form of text based form of reading
internet documents which is rarely used today).

Internet Functions
The internet provides for the following two functions which support communications. Without
the communications support mentioned below, the internet could not function. These two
functions are provided by internet service providers listed below under the "Internet
Organizations" header.



Physical lines that data is sent across.
Routing of data - There are special machines on the internet called routers, that determine
where data needs to go to get from the sender of the data to the receiver of the data.

Internet Organizations


ISPs (Internet Service Providers) - They provide the connection to the internet for users
and also provide routers that direct internet traffic.
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Corporations or Web hosting providers with mail servers and web servers - They provide
the information posted on the internet and virtual data connections to other mail servers.

There are also other organizations that regulate the internet, providing communication standards
and designing new communication standards for improvements. These communication standards
are also known as protocols.

Summary
So the internet is a collection of organizations that provide equipment that support the internet
functions and services. The internet connects many corporate and organizational private
networks together thus enabling all these organizations to easily communicate.

Accessing the Internet
People use an internet browser to access web pages that are available across the internet. Internet
browsers include Microsoft Internet Explorer, Netscape Navigator, Mozilla, and others.
Web pages are created in a marked up form of text file called HTML (Hyper-Text Markup
Language). The markup within the text indicates document structure showing where paragraphs
begin and end, what items are in a list, headers, tables and other document structure.
When people are browsing of surfing the internet, they usually go from place to place by clicking
on links. These links are locations for specific pages and indicate the three things:
1. Protocol being used such as http or ftp
2. The domain that the web page is found on. This will point to a specific organization's or
company's web server.
3. The location of the page on the server including the directory path and file name.
An example link is "http://www.comptechdoc.org/basics/bastutorial/osintro.html". In this case
http is the protocol being used, the comptechdoc.org domain indicates where the organization's
web server is, and the "/basics/bastutorial/osintro.html" part of the string indicates the folders the
file is in and the name of the file.
These links are sometimes called hyperlinks or URLs (Uniform Resource Locators)
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Operating System
The operating system is the core software component of your computer. It performs many
functions and is, in very basic terms, an interface between your computer and the outside world.
In the section about hardware, a computer is described as consisting of several component parts
including your monitor, keyboard, mouse, and other parts. The operating system provides an
interface to these parts using what is referred to as "drivers". This is why sometimes when you
install a new printer or other piece of hardware, your system will ask you to install more software
called a driver.

What does a driver do?
A driver is a specially written program which understands the operation of the device it
interfaces to, such as a printer, video card, sound card or CD ROM drive. It translates commands
from the operating system or user into commands understood by the the component computer
part it interfaces with. It also translates responses from the component computer part back to
responses that can be understood by the operating system, application program, or user. The
below diagram gives a graphical depiction of the interfaces between the operating system and the
computer component.
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Other Operating System Functions
The operating system provides for several other functions including:



System tools (programs) used to monitor computer performance, debug problems, or
maintain parts of the system.
A set of libraries or functions which programs may use to perform specific tasks
especially relating to interfacing with computer system components.

The operating system makes these interfacing functions along with its other functions operate
smoothly and these functions are mostly transparent to the user.

Operating System Concerns
As mentioned previously, an operating system is a computer program. Operating systems are
written by human programmers who make mistakes. Therefore there can be errors in the code
even though there may be some testing before the product is released. Some companies have
better software quality control and testing than others so you may notice varying levels of quality
from operating system to operating system. Errors in operating systems cause three main types of
problems:
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System crashes and instabilities - These can happen due to a software bug typically in the
operating system, although computer programs being run on the operating system can
make the system more unstable or may even crash the system by themselves. This varies
depending on the type of operating system. A system crash is the act of a system freezing
and becoming unresponsive which would cause the user to need to reboot.
Security flaws - Some software errors leave a door open for the system to be broken into
by unauthorized intruders. As these flaws are discovered, unauthorized intruders may try
to use these to gain illegal access to your system. Patching these flaws often will help
keep your computer system secure. How this is done will be explained later.
Sometimes errors in the operating system will cause the computer not to work correctly
with some peripheral devices such as printers.

Operating System Types
There are many types of operating systems. The most common is the Microsoft suite of operating
systems. They include from most recent to the oldest:










Windows XP Professional Edition - A version used by many businesses on workstations.
It has the ability to become a member of a corporate domain.
Windows XP Home Edition - A lower cost version of Windows XP which is for home
use only and should not be used at a business.
Windows 2000 - A better version of the Windows NT operating system which works well
both at home and as a workstation at a business. It includes technologies which allow
hardware to be automatically detected and other enhancements over Windows NT.
Windows ME - A upgraded version from windows 98 but it has been historically plagued
with programming errors which may be frustrating for home users.
Windows 98 - This was produced in two main versions. The first Windows 98 version
was plagued with programming errors but the Windows 98 Second Edition which came
out later was much better with many errors resolved.
Windows NT - A version of Windows made specifically for businesses offering better
control over workstation capabilities to help network administrators.
Windows 95 - The first version of Windows after the older Windows 3.x versions
offering a better interface and better library functions for programs.

There are other worthwhile types of operating systems not made by Microsoft. The greatest
problem with these operating systems lies in the fact that not as many application programs are
written for them. However if you can get the type of application programs you are looking for,
one of the systems listed below may be a good choice.




Unix - A system that has been around for many years and it is very stable. It is primary
used to be a server rather than a workstation and should not be used by anyone who does
not understand the system. It can be difficult to learn. Unix must normally run an a
computer made by the same company that produces the software.
Linux - Linux is similar to Unix in operation but it is free. It also should not be used by
anyone who does not understand the system and can be difficult to learn.
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Apple MacIntosh - Most recent versions are based on Unix but it has a good graphical
interface so it is both stable (does not crash often or have as many software problems as
other systems may have) and easy to learn. One drawback to this system is that it can
only be run on Apple produced hardware.

Applications
What is an application
Applications are programs that are installed. on computers to give users the ability to do specific
tasks. For example, Microsoft Word® is a program that gives the user the ability to write
documents. Some program packages come in a set with multiple programs included to provide
multiple capabilities such as the Microsoft Office® suite of programs. This suite of programs
also includes Microsoft Outlook® which is used to send and receive e-mail. It also includes other
programs with more capabilities.

How Application Programs Work
Application programs are written in a text based computer language as mentioned in the section
about hardware and software. Once written, they are compiled into a binary language the
computer understands. The application programs use function calls (as described in the section
about operating systems) to interface to the various computer peripherals such as your keyboard,
mouse, screen, printers, and other devices. Most of these function calls are provided by the
operating system so the application programs are usually compiled for a specific operating
system such as Microsoft Windows 2000®, Microsoft Windows XP®, or Microsoft Windows
98®.

Application Problems
An application program is a computer program. It is written by human programmers who make
mistakes. Therefore there can be errors in the code even though there may be some testing before
the product is released. Application programs vary widely in the quality of the code. Errors in
code are referred to as "bugs". Bugs can cause unpredictable results including system crashes,
inability to perform expected functions, or providing an exploit for an attacker who wants to gain
control of your system.
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Internet Security
Viruses and Worms
In general terms a virus is a program that runs on a system against the owner's or user's wishes
and knowledge. Viruses have one or more methods they use to spread. Most commonly they will
attach a file to an e-mail message and attempt to trick victims into running the attachment.

Virus Damage
In most cases, viruses can do any amount of damage the creator intends them to do. They can
send your data to a third party and then delete your data from your computer. They can also ruin
your system and render it unusable without a re-installation of the operating system. Most have
not done this much damage in the past, but could easily do this in the future. Usually the virus
will install files on your system then will change your system so the virus is run every time you
start your system. It will then attempt to replicate itself by sending itself to other potential
victims.
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The normal effect a virus will have on your system is that over time your system will run slower.
Also when you are using the internet your connection may seem to run slower. Eventually you
may have trouble running programs on your system, your system may freeze, and in the worst
case you may not be able to get it to boot up when you turn your computer on.

How Viruses or Worms Spread






Most commonly viruses today use e-mail to spread however they have used one or more
of the following methods to spread in the past.
Some viruses will load themselves onto any part of a writable removable drive as
possible and spread from computer to computer as people use the removable drive.
A worm is a program similar to a virus that will exploit a vulnerability in an operating
system or application that a computer user is running. The best defense against a worm is
to have either a personal firewall on your system or be behind a corporate firewall.
Another good defense is to update your system regularly. All you need to do to get a
worm is to connect an unpatched computer to the internet or infected network when your
computer does not have firewall protection.
Most viruses will spread themselves using e-mail attachments. They may tell the user that
they neet to open the attachment to get the rest of the information that is being sent to
them. Many times the virus may claim it is an administrator and the user needs to either
read the data or install a program on their system. Viruses have even claimed to be
Microsoft sending a system patch as an attachment to the e-mail. Microsoft would never
send a system patch through e-mail.

Worms and Prevention
Since worms spread by taking advantage of vulnerabilities in operating systems or application
programs (remember from earlier discussion, vulnerabilities are software errors that allow some
kind of unauthorized access when they are used or exploited). You do not need to do anthing
special to get a worm except to connect to the internet or an infected network with a system that
has vulnerabilities. There are several good defenses against worms.

What is a Firewall?
A firewall is a device that limits access to your system from the outside. A firewall may be a
software program running on your computer or it may be a piece of hardware outside your
computer. The firewall screens any attempts to access your system and only allows access that
you decide to allow. In this way much vulnerability that could be used to gain unauthorized
access to your system are eliminated.
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Worm Prevention
There are three defenses against worms. They are as follows:






A personal firewall should be run on any system that is not behind a corporate firewall.
This should be done on any computer that connects to the internet even if the connection
it uses is a slow dial up connection.
Patching your system with updates to fix the vulnerabilities. Patching is the act of
downloading updates to the vulnerable operating system or application and applying the
update to the program.
Continually running anti-virus software which may detect worms. This is not the best
defense against worms however because sometimes the worm can infect the system
before the anti-virus software can detect it.

Of the above measures the first two are the most effective against worms.

Securing Your System
There are several measures which you can take to secure your system. The first and most
important is to become informed about how your system works and what the threats are. Reading
this guide and acting on the tips contained here is a good start.










Personal firewall - If you are not behind a corporate firewall, purchase and install a
personal firewall on your computer. This will help protect your system from many
vulnerabilities that some worms will try to exploit.
Updates - Perform system updates often. You can go to the Windows Update site to
download updates for your system. Another way to get updates if your system is running
Windows 2000 or Windows XP is to configure your system to download automatic
updates. This can be done by opening your control panel (Click on "Start", then select
"Settings", and click on "Control Panel". To configure updates double click the
"Automatic Updates" icon and choose one of three configurations.
Use anti-virus software with regular updates. Be sure to run anti-virus software and
download updates at least twice per week. There are many brands of anti-virus software
which may be purchased at your local computer, office supply store, or on the internet. I
will not be recommending any name brands in this tutorial.
Be aware of how viruses spread and don't open attachments unless you are SURE they
are legitimate. Call the sender if necessary to be sure they sent the email. Be sure your
system settings are set so you can recognize potential virus files that may have multiple
extensions such as filename.txt.exe. If the extension ends in .exe, .com, or .bat don't
double click on it or run it unless you are SURE it is from a legitimate source.
Avoid installing bad applications. As mentioned in the section about application
programs, some computer programs may come with spyware or adware. Avoiding these
can be important in both securing your system and keeping your system performance
from being degraded. Keep in mind that adware programs may download and install
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other programs from the internet. A personal firewall is one defense against this
happening because it will normally notify you when a program accesses the internet.
Configure your system so you will see all file extensions as described on the page called
"Windows File View Settings".

The Internet Email System
The email system that is currently used on the internet was not designed to curb the abuses
presented by viruses and SPAM as they are occurring today. The email system today allows:




Anyone can set the "From" field in the email to any value they want. This means that you
can send an email message and make it look like the President of the United States sent
the message. There are ways to tell that this is not the case, but on the surface it will
appear like the President of the United States sent the message. This is called faking the
sending address.
If an email cannot be delivered, the email standard provides for the sender to receive a
notification indicating that the message could not be delivered. Some email servers are
also set up to notify the sender when a virus is found in an email they sent.

There are several things that the email system in use today does not provide for:



The system does not provide for positive identification of the sender.
There is no method to prevent a sender from sending unwanted emails.

Email Problems
Given the above conditions, several problems can occur.






If the sending address of the email is faked, any messages indicating the message could
not be delivered will go to the person who appears to have sent the email rather than the
person who actually sent it. This can cause people to receive non deliverable notifications
for emails that they did not send which can be very confusing.
If a virus sends an email with a faked sender address, a mail server may detect the virus
in the message and send a reply to the faked address notifying someone that they sent an
email with a virus in it when in fact they did not. This can cause confusion and waste
administrators time since users may call administrators and want their systems checked
for viruses when they are not acutally infected with a virus. This is why administrators of
mail servers should turn off notifications to addresses that appear to have sent a virus.
Someone can fake the sender of an email and send embarrassing or annoying messages
and possibly jeopardize the reputation of the party they are sending the email as. They
can make it appear as though a reputable party is sending smut on the internet. I do not
know if there are any laws against this, but there should be. This would be called fraud
along with some possible other charges such as libel and slander. There are ways to tell
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that the sender did not actually send the email but this could still unjustly hurt someone's
reputation.
Recipients of virus or SPAM emails are unwilling recipients. These emails tie up their
time and computer resources. When someone pays for a connection to the internet, and
this connection is used to send them unwanted emails, this is the same as a denial of
service attack and is essentially stealing. Everyone who connects to the internet has the
right to use their connection haw they want and not how someone else wants. I will talk
more about this in the section about SPAM.

E-mail Viruses
Viruses that spread through e-mail have a common method of spreading. This page will discuss
how common e-mail viruses currently spread.

The Virus Lifecycle
Viruses begin their life when someone releases them on the internet. They begin to spread. At
this early stage of their lifecycle, no one is aware of their presence. As the virus becomes more
widely spread, someone will recognize an abnormal problem with their system and investigate.
Eventually a computer expert will conclude that a virus exists and notify companies that write
anti virus software. The companies will research the virus and come out with an update to their
database of viruses that includes information about the new virus and has information about how
to recognize it. They may also release a tool that can be used to automatically remove that virus
from computer systems.
Therefore the cycle is:
1.
2.
3.
4.

Release - The virus is released.
Recognition - Someone recognizes the virus.
Virus recognition database update - Antivirus programs will now recognize the virus.
Antiivirus update and removal tools

The time between step one and step three above can be significant. During this time you are
vulnerable to getting the virus because your anti-virus software will not recognize it as a virus.
This is why you should be careful about the e-mail attachments that you open, even if you are
actively running anti-virus software.
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UP GRADATION OF COMPUTER OPERATION SKILLS
PRE-TRAINING
EVALUATION TEST

1. The Office application that enables you to create documents such as letters and reports is
called.
( )
a)
b)
c)
d)
e)

Microsoft Excel
Microsoft Access
Microsoft Word
Microsoft PowerPoint
Internet Explorer

2. The Office spreadsheet application is called.
a)
b)
c)
d)
e)

)

(

)

Microsoft Excel
Microsoft Access
Microsoft Word
Microsoft PowerPoint
Internet Explorer

3. The Office application that enables you to create slides, outline,
speacker's notes, and audience handouts is called.
a)
b)
c)
d)
e)

(

Microsoft Excel
Microsoft Access
Microsoft Word
Microsoft PowerPoint
Internet Explorer

4. The Office application that organizes information in database format is called. (
a)
b)
c)
d)
e)

)

Microsoft Excel
Microsoft Access
Microsoft Word
Microsoft PowerPoint
Internet Explorer

5. The Office schedule / organization application is called.
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(

)

a)
b)
c)
d)
e)

Microsoft PowerPoint
Microsoft Publishing
Microsoft Outlook
Internet Explorer
Netscape

6. The Office Web Page application is called.
a)
b)
c)
d)
e)

(

)

(

)

(

)

(

)

(

)

Microsoft PowerPoint
Microsoft Publishing
Microsoft Outlook
Internet Explorer
Netscape

7. The only way to start an Office application is from the Programs
menu on the Start Menu.
a) True
b) False

8. You can have multiple Office applications open at the same time.
a) True
b) False

9. The World Wide Web and the Internet are the same thing.

a) True
b) False
10. The terms "document" and "file" are interchangeable.
a) True
b) False

11. You can locate the disk drive containing the file you want to open in the
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(

)

a)
b)
c)
d)

Look in box
Files of type box
Save in box
Open in box

12. The quickest and easiest way to save and print documents is by using the
a)
b)
c)
d)

)

(

)

(

)

(

)

Screen Tips
Office Assistant
Tool Tips
Office Wizard

15. A feature found in Office, which offers ways to get help is called.
a)
b)
c)
d)

(

the Close command on the Edit menu
the Exit command on the Tools menu
the Quit command on the File menu
the Exit command on the File menu

14. If you want to know the function of a toolbar button, which feature
would you use.
a)
b)
c)
d)

)

menu bar
options window
toolbar
taskbar

13. You can quit and Office application by using
a)
b)
c)
d)

(

Office Buddy
Office Assistant
Office Monitor
Office Wizard

16. In what order should be performed to open Microsoft Word from the
Start menu.
a) Point to the Program folder, Click the Start button on the taskbar, Click
on Microsoft Word
b) Click the Start button on the taskbar, Point to the Program folder, Click
on Microsoft Word
c) Click on Microsoft Word, Point to the Program folder, Click the Start
button on the taskbar
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17. If you want to save your file, Budget, under a new name, Expense, which steps should be
performed.
( )
a) Choose Save As from the File Menu, In the File name box, type Expenses, Click
Save to save the file with a new name, Make sure that your file Budget is on
screen
b) Make sure that your file Budget is on screen, Click Save to save the file with a
new name, In the File name box, type Expenses, Choose Save As from the File
Menu
c) Choose Save As from the File Menu, Make sure that your file Budget is on
screen, In the File name box, type Expenses, Click Save to save the file with a
new name
18. To save a file with a new filename or to a new location, choose the Save command in the
File menu.
( )
a) True
b) False
19. The Office Partner is an animated help character that offers tips and messages to help you
work more efficiently.
( )
a) True
b) False
20. What is a spider?

a)
b)
c)
d)

)

(

)

(

)

A computer virus
A program that catalogs Web sites
A hacker who breaks into corporate computer systems
An application for viewing Web sites

21. What is not always necessary for accessing the Web?
a)
b)
c)
d)

(

A Web browser
A connection to an Internet Access Provider
A computer
A modem

22. If someone has sent you spam, they...
a) Signed you up for the Meat of the Month Club
b) Sent you an insulting, obscenity-laden e-mail message
c) Infected your computer with a virus
d) Sent you unsolicited e-mail
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23. What does WWW stand for?
a) World Wacky Web
b) Wide World Wumpus
c) World Wide Web
d) Wide World of Why?

(

)

24. Which one of the following is a search engine?

(

)

(

)

(

)

(

)

a)
b)
c)
d)

Netscape
Java
Google
Internet

25. What is the URL of the search engine ?

a)
b)
c)
d)

http://www.yahoo.com
http://www.google.com
http://www.yahooligans.org
http ://www.altavista.com

26. What does URL stand for?

a)
b)
c)
d)

united route link
uniform resource locator
unknown redirection link
up real late

27. What is the name of the language you use to write a web page?

a)
b)
c)
d)

HTTP
FTP
URL
HTML
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UP GRADATION OF COMPUTER OPERATION SKILLS
POST-TRAINING
EVALUATION TEST
1. What are the consequences if download files from the Internet to your
computer?

a)
b)
c)
d)

5.

6.

(

)

(

)

(

)

an important word
the web address
a "link" to another web page
a mistake

In order to save an existing document with a different name you need to
a)
b)
c)
d)

)

htp
http://
http:/
WWW

4. A word that looks underlined on a web page is usually what?

a)
b)
c)
d)

(

Netscape
World Wide Web
Launcher
E-mail

3. All web addresses start with which of the following?

a)
b)
c)
d)

)

You can play lot of games
Or listen to lot of music
Your computer will get full up of junk
You might download a virus and put your computer and other at risk, always check if
the download site is trustworthy

2. Which of the following terms is a "browser"?

a)
b)
c)
d)

(

Retype the document and give it a different name.
Use the Save as.. Command.
Copy and paste the original document to a new document and then
save.
Use Windows Explorer to copy the document to a different location and then rename
it.

Which keyboard shortcut bolds selected text?
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(

)

a)
b)
c)
d)

7.

Ctrl + B
Alt + B
File / Format / Bold
None of the above

How can you highlight text without using the mouse?
a)
b)
c)
d)

(

)

(

)

(

)

(

)

You can see all pages of your document
You can only see the page you are currently working
You can only see pages that do not contain graphics
You can only see the title page of your document
Which elements of a Word document can be displayed in color?

11. Which elements of a Word document can be displayed in color?
a)
b)
c)
d)

)

Your program has been infected by a macro virus
This version of Word does not support toolbars
Your toolbar option has been deleted from the menus
Your toolbar has been unchecked under the View/Toolbars menu

10. In page preview mode:
a)
b)
c)
d)
e)

(

The word "write" is misspelled
No errors
The verb of the phrase will be highlighted
A blue squiggly underline under the word "write"

9. Suddenly word does not display your favourite toolbar. What has happend?
a)
b)
c)
d)

)

It is impossible
Use the F5 key
Use the arrow keys while holding down a Ctrl key
Use the arrow keys while holding down a Shift key

8. What would you see while spell checking the phrase "My father was write"?
a)
b)
c)
d)

(

Only graphics
Only text
All elements
All elements, but only if you have a color printer

12. The background of any Word document:
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a)
b)
c)
d)

Is always white color
Is the color you preset under the Options menu
Is always the same for the entire document
Can have any color you choose

13. In Word you can force a page break:
a)
b)
c)
d)

(

)

(

)

(

)

Tab
Shift
Enter
Ctrl+Enter

17. How many different documents can you have open at one time?
a)
b)
c)
d)

)

TXT/TRF
WRD
FIL
DOC/DOCX

16. Which key moves your cursor from one cell to the next in a table?
a)
b)
c)
d)

(

Ctrl + C
Alt + C
There is no keyboard shortcut for this operation
Ctrl + M

15. What is the default file extension for all word documents
a)
b)
c)
d)

)

By positioning your cursor at the appropriate place and pressing the F1 key
By using the Insert/Section Break
By positioning your cursor at the appropriate place and pressing Ctrl+Enter
By changing the font size of your document

14. Which keyboard shortcut centers selected text
a)
b)
c)
d)

(

No more that three
Only one
As many as your computer memory will hold
No more than your Taskbar can display
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18. In order to email a word document from within word:
a)
b)
c)
d)

(

)

(

)

(

)

Put the appropriate graphics and links on the document
Save the document in simple text format
Use your web browser as an editor and save as URL
Save as HTML

22. A document in portrait prints:
a)
b)
c)
d)

)

Two (header and footer)
Four (top, bottom, right, left)
Two (landscape and Portrait)
Two (top and bottom)

21. In order to save a word document as a web page you need to :
a)
b)
c)
d)

(

Ctrl + PageUp and Ctrl + PageDown
Shift + Home and Shift + End
Ctrl + Home and Ctrl + End
The only way is by using the right scroll bar

20. How many margins are on a page?
a)
b)
c)
d)

)

Go to File / Send To / Mail Recipient
Save the file as an email attachment
Start Outlook and attach the file while open in Word
This is an impossible operation

19. Which keystroke will take you at the beginning or the end of a long document?
a)
b)
c)
d)

(

The same characters per line with the same document in landscape
More characters per line than the same document in landscape
Less characters per line than the same document in landscape
Smaller fonts in order to fit the same amount of characters per line with landscape

23. Should we open a another object in windows

(

)

(

)

a) Yes
b) No
c) Can't Say

24. What can you do with the Internet?
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a)
b)
c)
d)
e)

Exchange information with friends and colleagues
Access pictures, sounds, video clips and other media elements
Find diverse perspective on issues from a global audience
Post and respond to inquiries on a variety of subjects
All of the above

25. The Internet was developed in the...
a)
b)
c)
d)

)

(

)

(

)

early 1990s
late 1980s
early 1970s
late 1960s

26. According to CNN, how much did Internet traffic increase between
1994 and 1996?
a)
b)
c)
d)

(

Two times
Five times
Ten times
Twenty-five times

27. USENET is...

a) A set of tools reserved exclusively for Internet administrators
b) Short for United States Electronic Network
c) A bulletin board system that allows for posting and responding to messages on the
Internet
d) A precursor to the Internet that is now obsolete

28. True or false: The Internet is managed by the U.S. government
a) True
b) False
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